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1. Uvod - Tehnologija Štampanih Ploča 
 

 

Štampana ploča ili PCB (Printed Circuit Board) je ploča koja obezbeđuje mehaničku potporu i 
električno povezivanje komponenti koje sačinjavaju elektronski uređaj. Osnova ploče je obično 
napravljena od vrste fiberglasa koja ima oznaku FR4 Tg130 (kompozitni materijal sastavljen od 
tkanine fiberglasa i vezivnog materijala epoksidne smole). Ovaj materijal obezbeđuje krutost i ima 
svojstva otpornosti na toplotu i plamen. Tg130 (ili Tg140/150/155) označava parametar 
„glass transition temperature“ i odnosi se na osnovu materijala. Tipičan izgled FR4 ploče 
prikazan je na Slici 1. 

 
Slika 1.  Izgled FR4 materijala za izradu štampane ploče 

 
FR4 Tg150 ploče imaju bolju otpornost na plamen od osnovnih FR4 ploča sa oznakom Tg140. U 
posebnim slučajevima koriste se FR4 Tg155 ploče: 
 
• Kada se PCB izrađuje na 4 ili 6 slojeva, 
• Kada se PCB izrađuje za automobilsku ili vojnu industriju 
• Kada se na PCB-u nalaze vodovi debljine svega 4 mil-a, ili kada je 15 mil-a rastojanje između vija. 

• Kada PCB sadrži BGA (Ball Grid Array) komponente. 
 
Debljine ovakvih štampanih ploča se mogu razlikovati u zavisnosti od dizajna, ali je tipična 
debljina 1.6 mm. Na gornjoj stranici štampane ploče nalazi se nalepljen veoma tanak sloj bakra 
tipično debljine 30 µm tj. 1 oz, ili 70 µm tj. 2 oz, koji omogućava da se elektronske komponente 
mehaničkom vezom pričvrste (zaleme) za provodni deo ploče. U zavisnosti od složenosti uređaja 
koji se projektuje, za njegovu realizaciju se mogu koristiti i štampane ploče koje imaju više slojeva 
bakra. Između dva sloja bakra obavezno mora postojati izolacioni sloj. Prema broju slojeva, 
štampane ploče se mogu podeliti na: 

 
 Jednoslojne ploče, kod kojih je sa jedne (gornje ili donje) strane FR4 ploče nanesen tanak 

sloj bakra. 
 Dvoslojne ploče, kod kojih postoji sloj bakra kako sa gornje, tako i sa donje strane. 
 Višeslojne ploče, koje imaju “sendvič” strukturu i kod kojih postoji više provodnih bakarnih 

slojeva, razdvojenih izolatorskim slojevima od osnove FR4. 
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1.1.Podela elektronskih komponenti prema načinu montaže na PCB 
 
 
Svaka komponenta koja se koristi pri realizaciji uređaja fizički je smeštena u odgovarajuće kućište. 
Međusobno povezivanje komponenti vrši se preko njihovih električnih izvoda (nožica, odnosno 
pinova). Datasheet je dokument koji definiše proizvođač komponente i u kojem se nalaze 
relevantni podaci o konkretnoj komponenti: simbol, kritični parametri komponente, kućište u koje 
je upakovana, fizičke dimenzije kućišta, raspored pinova na komponenti, objašnjenje koju funkciju 
obavlja svaki od tih pinova i sl. Poslednjih godina, poluprovodnička tehnologija je evoluirala sa 
povećanom potražnjom za većom funkcionalnošću, manjom veličinom i dodatnom korisnošću. 
Savremeni dizajn PCB-a ima dve glavne metode za montiranje komponenata na PCB: montiranje 
kroz rupe (Trough hole) i površinsko montiranje (Surface Mounting), kao što prikazuje  Slika 2. 
 

 
Slika 2.  Izgled komponenti koje se montiraju kroz rupe (prikaz levo) i komponenti koje se montiraju površinski (prikaz desno)  

 

1.1.1. Komponente koje se motiraju kroz rupe (Trough hole) 
 
Montaža kroz rupe (Trough hole) je postupak kojim se pinovi komponenata postavljaju u 
izbušene rupe na PCB-u. Proces je bio uobičajena praksa sve do uspona tehnologije površinskog 
montiranja (SMT) 1980-ih.   
Komponente kroz rupe i dalje se koriste za proizvode visoke pouzdanosti koji zahtevaju čvršće 
veze između slojeva. Dok su SMT komponente osigurane samo lemljenjem na površini ploče, 
montaža kroz rupe omogućava komponentama da izdrže veći stres okoline. Zbog toga se ovakva 
tehnologija često koristi u vojnim i vazduhoplovnim proizvodima koji mogu doživeti ekstremna 
ubrzanja, sudare ili visoke temperature. Takođe je korisna u aplikacijama za testiranje i izradu 
prototipova koje ponekad zahtevaju ručna podešavanja i razlemljavanje prilikom zamene. 
 

1.1.1.1. Aksijalne i radijalne Truough hole komponente 
 
Postoje dve vrste komponenata koje se montiraju kroz rupe: aksijalne i radijalne. Aksijalne nožice 
prolaze kroz komponentu u pravoj liniji („aksijalno“), pri čemu svaki kraj olovne žice izlazi iz 
komponente na oba kraja. Oba kraja se zatim provlače kroz dve odvojene rupe na ploči, 
omogućavajući komponenti da se bliže, ravnije uklopi. Sa druge strane, kod radijalnih komponenti 
su izvodi smešteni na jednoj strani komponente. 
Oba tipa komponenata kroz rupe su "dvostruke" olovne komponente i obe imaju svoje posebne 
prednosti. 
Dok se aksijalne olovne komponente koriste zbog čvrstoće na ploči, radijalne komponente 
zauzimaju manje površine, što ih čini boljim za ploče velike gustine. Generalno, konfiguracija 
aksijalne komponente može biti u obliku ugljeničnog otpornika, elektrolitskih kondenzatora, 
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osigurača itd. Primer komponente radijalnog tipa su kondenzatori sa keramičkim diskom, diode 
koje emituju svetlost (LED). Na Slici 3 su prikazane aksijalna i radijalna komponenta. 
 

 
 

Slika 3.  Primer aksijalne komponente (prikaz levo) i radijalne komponente (prikaz desno) 

 
Prednosti: Truough hole tehnologija pruža jače mehaničke veze od SMT-a, čineći je idealnom za 
komponente koje mogu pretrpeti mehaničko naprezanje, poput konektora ili transformatora. 
Takođe su dobre za test i izradu prototipova. 
 
Mane: Zahteva se bušenje rupa, što je skupo i dugotrajno. Takođe ograničava se dostupno područje 
rutiranja na bilo kojoj višeslojnoj ploči, jer izbušene rupe moraju da prođu kroz sve slojeve PCB-
a. Dalje, Trough Hole montaža zahteva upotrebu tehnika selektivnog ili ručnog lemljenja, koje su 
mnogo manje pouzdane i ponovljive od reflov rerni koje se koriste za površinsko postavljanje. 
Najviše od svega, tehnologija zahteva lemljenje sa obe strane ploče, za razliku od površinskih 
nosača, koji - uglavnom - zahtevaju interakciju na jednoj strani ploče. 
 
 

1.1.2. Komponente koje se montiraju površinski (Surface mount) 
 
Surface-Mounting Technology (SMT) je tehnologija kod koje se komponente montiraju direktno 
na površinu PCB-a. Prvobitno poznata kao „planarno montiranje“, metoda je razvijena 1960-ih, a 
sve popularnija od 1980-ih. Danas se gotovo sav elektronski hardver proizvodi pomoću SMT-a. 
Ključne razlike između SMT i montaže kroz rupe su: (a) SMT ne zahteva bušenje rupa kroz PCB, 
(b) SMT komponente su mnogo manje i (c) SMT komponente mogu se lakše montirati. 
  
 
Označavanje: 
SMA (sklop za površinsko montiranje) - sklop ili modul sastavljen pomoću SMT-a. 
SMC (komponente za površinsku montažu) - komponente za SMT. 
SMD (uređaji za površinsku montažu) - aktivne, pasivne i elektromehaničke komponente. 
SME (oprema za površinsku montažu) - mašine koje se koriste za SMT. 
SMP (paketi za površinsko montiranje) - oblici SMD kućišta. 
SMT (površinska tehnologija) - način sklapanja i montiranja ove elektronske tehnologije. 
 
Budući da su uređaji za površinsku montažu (SMD) u ekspanziji i da se ova tehnologija 
neprestano širi, potpuno pokrivanje ove klasifikacije je gotovo nemoguće, ali neke tipove je 
veoma važno poznavati: 
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MELF (Metal Electrode Face Bonded): Sastoje se od dva terminala vezana za cilindrično telo, 

ove SMD komponente su jeftinije od ravnih čipova, ali 
zahtevaju posebnu pažnju tokom montaže. Štaviše, jedan od 
njihovih najvećih nedostataka je njihova tendencija da se 
kotrljaju po lemnoj podlozi tokom lemljenja. Uopšteno 
govoreći, dolaze u obliku dioda, otpornika i kondenzatora. 
 

 
SOT tranzistori i diode:  

 
Obično su pravougaone i lako ih je postaviti, mada su pomalo zastareli. 
Najčešći SOT-ovi su SOT 23, SOT 89, SOT 143 i SOT 223. Najčešće 
pakovanje je traka i kolut. 
 
 

 
 
 
Integralna kola (IC): 
 

SOIC (Integralna kola malog obima) - Ovo su dobre SMT alternative dualnom 
linijskom paketu  (DIP), zbog njihove dramatično smanjene veličine. Generalno, 
zauzimaju 30 - 50% manje prostora i 70% manje debljine od prosečnog DIP-a. 
 

 
 

 TSOP (Thin Small Outline Package) – obično su namenjeni za smeštaj 
velikih silicijumskih čipova u paketima velike gustine (RAM-ovi ili IC 

memorije fleš memorije), uglavnom zbog njihovog malog obima / velikog 
broja pinova. 

 
 
 

 Quad Flat Pack (QFN) - su paketi sa velikim brojem pinova (44 - 304). Postoji 
mnogo vrsta QFN pakovanja i oni su jedan od najčešćih IC-a za površinsko 
montiranje. 
 

 
 

 PLCC (Plastic Leaded Chip Carrier) - veze se ostvaruju na sve četiri ivice 
kvadratnog pakovanja sa relativno velikim brojem pinova. PLCC mogu imati 
otprilike 18 - 100 nožica. Mnogi od njih se mogu uklopiti u IC utičnice (sockete) 
i mogu se lako zameniti na terenu. PLCC su odavno popularna opcija. 
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 LCC (Lead-less Chip Carrier) - Da se ne bi pomešao sa PLCC, LCC nemaju 
klasične nožice. Umesto toga, LCC se leme direktno na PCB pomoću njihovih 
(kastelacionih) lemnih pločica. Obično su dizajnirani za Mil Spec, jer su bez 
oštećenja prilično „robusni“. LCC su odlični za primenu na visokim 
temperaturama i u vazduhoplovstvu. 

 
 

 
PGA (Niz rešetkastih mreža) su obično kvadratni ili pravougaoni, sa 
pinovima (iglicama) raspoređenim ispod paketa. Dizajn je imao veliki uticaj 
na sada sveprisutni BGA. Procesori se najčešće nalaze u ovakvim kućištima. 
 

 
BGA (Ball Grid Array) su možda jedan od SMT paketa sa najboljim 
performansama koji se danas koriste, zbog svoje velike gustine. BGA je nastao 
po uzoru na PGA-a, ali umesto pinova ima lemljene kuglice koje se mogu 
postaviti direktno na PCB. Zbog velike gustine, BGA se obično koriste za 
smeštaj mikroprocesora. 

 
 
Prednosti: SMT omogućava manju veličinu PCB-a, veću gustinu komponenata i više slobodnog 
prostora za rutiranje. Budući da nije potrebno bušiti dodatne rupe, SMT omogućava niže troškove 
i kraće vreme proizvodnje. Tokom montaže, SMT komponente mogu se postaviti brzinom od 
hiljade - čak i desetine hiljada komponenti na sat, u poređenju sa manje od hiljadu za Truough hole 
komponente. Formiranje lemnih čvorova je ponovljivije korišćenjem programiranih reflov peći u 
odnosu na Truough hole tehnike.  
 
Mane: SMT može biti nepouzdan kada se koristi kao jedini način pričvršćivanja komponenata 
podložnih mehaničkom naprezanju (tj. Spoljni uređaji koji su često pričvršćeni ili odvojeni). 
 
Površinska montaža će se gotovo uvek pokazati efikasnijom i isplativijom od montaže kroz rupe. 
Danas se koristi u više od 90 procenata PCBa. Međutim, posebna mehanička, električna i termička 
razmatranja i dalje će zahtevati Truough hole montažu, održavajući ga relevantnim i u budućnosti. 
 
 

1.2.Pričvršćivanje komponenti na ploču (Postupak lemljenja) 
 

Lemljenje je postupak kojim se istovremeno ostvaruju električni kontakt i čvrst mehanički spoj 

između pinova komponente i lemnih površina (engl. pad), koje pripadaju bakarnom sloju na 

površini ploče. U tu svrhu se koristi metal sa nižom temperaturom topljenja u odnosu na metale 

koji se ovim postupkom spajaju. Ranije je najčešće u tu svrhu korišćena legura koja sadrži oko 

60% kalaja (Sn) i 40% olova (Pb), ali je zbog štetnosti po okolinu prilikom isparavanja olova ovaj 

sastav uglavnom zamenjen sastavom gde preovladava kalaj (Sn) sa 99%. Ttrend je da se sledi 

RoHS direktiva, koja nalaže korišćenje lemnih legura bez olova iz ekoloških razloga. Nakon 

postavljanja komponente na ploču, lemna površina i nožica komponente se zagrevaju vrhom 

lemilice, uz prislanjanje žice koja sadrži lemnu leguru. Pri tome se legura topi i fizički oblaže 
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nožicu komponente i lemnu površinu. Nakon toga se lemilica udaljava, a ohlađena lemna legura 

ostvaruje željenu električnu i mehaničku vezu. Postupak lemljenja prikazan je na Slici 4.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Slika 4.  Postupak lemljenja komponente 

 
 

1.2.1. Ostvarivanje kontakta između različitih slojeva na štampanoj ploči 
 
Električne veze između nožica komponenti montiranih na štampanu ploču, odnosno njihovih 

lemnih površina, ostvaruju se pomoću provodnih traka (linija) koje su izvedene u sloju bakra na 

površini ploče. Postupak povezivanja komponenti provodnim linijama poznat je još i kao 

rutiranje. Višak bakra koji ne pripada provodnim trakama i lemnim površinama se uklanja 

odgovarajućim fizičkim ili hemijskim postupkom. Pošto su kod višeslojnih ploča slojevi bakra 

međusobno razdvojeni izolacionim slojem, u slučaju kada je potrebno ostvariti električni spoj 

između provodnih traka koje pripadaju različitim slojevima, spoj se ostvaruje korišćenjem vija 

(slika 3). Vija je otvor koji prolazi kroz jedan ili više slojeva ploče i koji je obložen provodnim 

materijalom, u postupku koji se naziva metalizacija. Na slojevima koji su spojeni na ovaj način 

postoje još i bakarne površine koje okružuju viju, na sličan naćin kao što je to slučaj sa lemnim 

površinama kod through-hole komponenti. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 3. Tipovi vija: “Through-hole”(1), “Slepa”(2), “Ukopana”(3). Neprovodni slojevi su predstavljeni 

zelenom i sivom, a provodni narandžastom i crvenom bojom. 
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1.2.2. Kratke smernice i pravila vezana za projektovanje čtampane ploče 
 

 

Pri projektovanju štampane ploče treba voditi računa o tome da budu ispunjeni sledeći zahtevi: 
 
o Poželjno je da razmeštaj komponenti po površini ploče bude takav da se približno poklapa sa 

rasporedom komponenti na šematiku. Dobrim rasporedom smanjuje se površina ploče i 

skraćuje se dužina linija, što smanjuje parazitne otpornosti i kapacitivnosti linija, poboljšava 

imunost uređaja na smetnje. 

o Takođe, treba voditi računa o tome da međusobna orjentacija komponenti bude takva da je broj 

ukrštanja mežu provodnim linijama minimizovan. To je važno ne samo zbog mogućnosti 

“preslušavanja”, nego zbog toga što olakšava rutiranje u istoj ravni, čime se smanjuje broj 

slojeva potrebnih za rutiranje. Razlika u ceni između jednoslojne, dvoslojne i višeslojne ploče 

je prilično značajan faktor, tako da se uvek teži ka realizaciji ploče korišćenjem minimalnog 

mogućeg broja slojeva, a da pri tom ne budu ugrožene performanse uređaja.  
o Ukupna površina ploče treba da bude što manja. Firme koje izrađuju ploče obično naplaćuju 

svoje usluge po jedinici površine, tako da je ekonomska motivacija očigledna, pogotovo kada 

su u pitanju veće serije. Naravno, pri smanjivanju dimenzija se prirodno nameću ograničenja 

diktirana dimenzijama samih komponenti, kao i izvodljivošću rutiranja u željenom broju 

slojeva.  
o Fizički razmeštaj komponenti može biti diktiran i prirodom samog uređaja. Tipičan primer za 

ovo su uređaji koji sadrže RF komponente, kod kojih je potrebno strikno pridržavanje 

preporukama proizvođača komponenti, kako bi bile postignute optimalne performanse po 

pitanju dometa emitovanja predajnika i/ili osetljivosti prijemnika. Takođe, u pojedinim 

uređajima u kojima se koriste komponente energetske elektronike kroz koje protiču značajnije 

struje, potrebno je takve komponente što više razdvojiti (ili čak galvanski izolovati) od 

kontrolne logike koja može biti osetljiva na smetnje koje ove komponente generišu. Takođe, 

pri povezivanju ovakvih komponenti, preporučljivo je koristiti deblje linije koje samim tim 

imaju manju podužnu otpornost, koja u ovakvim slučajevima može doći do izražaja. 

 
 

1.3.Ciklus razvoja elektronskog uređaja 
 

 

U ovom kursu će biti opisani osnovni koraci u razvoju elektronskog uređaja, sa akcentom na proces 

projektovanja štampane ploče, upotrebom softverskog paketa Altium Designer v.17. 
 
Prvi korak podrazumeva crtanje električne šeme uređaja, tako da njegova funkcionalnost 

zadovoljava zadatu specifikaciju. 

U toku crtanja šeme, vrši se izbor konkretnih komponenti koje će sačinjavati kolo po kriterijumu 

njihovih kataloških karakteristika, cene, dostupnosti na tržištu i sl. 

Pre nego što se pređe na fizičku realizaciju, poželjno je proveriti funkcionalnost koncepta izradom 

i testiranjem prototipa (npr. korišćenjem protoborda), ili simulacijom u nekom od za to predviđenih 

softverskih alata. Tokom ovog koraka se modifikuje šema tako da eventualno uočene greške i 
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propusti budu prevaziđeni ukoliko je to moguće, u suprotnom je potrebna promena koncepta 

samog uređaja.  
Imajući u vidu fizičke dimenzije i raspored nožica komponenti, pristupa se projektovanju štampane 

ploče. Ranije se ovaj postupak obavljao ručno, a u današnje vreme je to sofisticirano upotrebom 

softverskog CAD alata, Altium Designer-a. Pri tome je potrebno pridržavati se gore navedenih 

smernica. 

Kada je završeno sa projektovanjem štampane ploče, pristupa se postupku njene izrade, 

korišćenjem odgovarajućih fizičkih i/ili hemijskih metoda, ili angažovanjem firme koja se bavi 

izradom štampanih ploča.  
Na izrađenu ploču se postavljaju i leme komponente, a potom se pristupa testiranju gotovog 

uređaja. Kada je utvrđena željena funkcionalnost, uređaj je spreman za montažu u odgovarajuće 

zaštitno kućište i upotrebu. 
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2. Rad u programskom paketu: Altium Designer 
 

 

Programski paket Protel nastao je sredinom devedesetih godina XX veka kao jedan od prvih 

programskih paketa za dizajn i izradu štampanih pločica. Na svom početku postojanja nije imao 

izgled kakav danas poseduje, niti se pojavio pod imenom koji danas ima. U početku su postojala 

dva odvojena programa od kojih je jedan bio za izradu šema električnih kola (Schematic Editor), 

a drugi za prenos tih šema i izradu u tzv. PCB oblik (PCB Editor). U sledećoj verziji nazvanoj 

Protel, firma Altium objedinjuje ta dva programa u jedan programski paket koji predstavlja 

jedinstveni alat za projektovanje štampanih ploča, od šeme do finalnog izgleda ploče. Aktuelna 

verzija softvera pod nazivom Altium Designer predstavlja jedan u potpunosti zaokružen 

programski alat namenjen projektovanju, dizajnu, simulaciji i izradi štampanih pločica zajedno sa 

velikim brojem biblioteka elemenata koji se koriste u tom cilju kao i više nego funkcionalnim 

interfejsom za rukovanje procesom koji omogućava vrlo pregledan i brz pristup svim važnijim 

funkcijama u programu. U okviru softverskog okruženja Altium Designer postoji više manjih 

potprograma, od kojih će ovde akcenat biti na sledećim: 
 
o Schematic Library Editor omogućava kreiranje korisničkih biblioteka komponenti, koje će 

kasnije biti upotrebljavane u projektima.  
o Schematic Editor omogućava crtanje šeme uređaja, korišćenjem komponenti koje su 

definisane u postojećim bibliotekama komponenti i njihovim međusobnim povezivanjem. 

o PCB Library Editor omogućava kreiranje korisničkih biblioteka futprintova (otisaka) 

komponenti koje je potrebno postaviti na štampanu ploču 

o PCB Editor je program u kojem se definiše fizički izgled štampane ploče raspoređivanjem 

futprintova komponenti i njihovim povezivanjem provodnim vezama. 
 

Slika 4. Proces projektovanja štampane ploče korišćenjem Altium Designer-a 
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Proces projektovanja štampane ploče korišćenjem Altium Designer-a ilustrovan je dijagramom 

na Slici 4 i biće detaljnije objašnjen kroz primere u Vežbama 1 i 2. 

 
 

2.1.VEŽBA 1 a) Električna šema PIC programator-a u Shematic Editoru 
 

 
Cilj vežbe 1 (i vežbe 2) je da postupno prikaže rad u softverskom paketu Altium Designer, od 
kreiranja projekta do eksportovanja gerber fajlova, koji se koriste za fabrikaciju štampanih ploča. 
Najpre će biti objašnjeno kreiranje novog dokumenta u shematic editor-u, kao i dokumenta u 
Shematic bibliotekama, zatim uključivanje već postojećih biblioteka u novi projekat, čime će biti 
omogućeno crtanje shematskih simbola i kreiranje šeme uređaja. Nakon uspešne realizacije šeme, 
biće objašnjeno dodavanje/crtanje futprinta za svaku komponentu na šemi, a zatim eksportovanje 
komponenti na PCB kao rutiranje same štsmpane ploče. 

 
 

2.1.1. Opis projekta PIC programator 
 

 
Prvi projektni zadatak će biti kreiranje štampane ploče (odnosno PCB-a) programatora za PIC 

mikrokontrolera. Cilj je omogućiti programiranje najpopularnijih tipova jeftinih i moćnih 

kontrolera proizvođača Microchip, koji pokrivaju serije PIC12F, PIC16F, PIC24F, DSPIC30F itd. 

(http://www.ke4nyv.com/picprojects.htm). Šema ovog projekta se sastoji od svega nekoliko 

elemenata, podnožja mikrokontrolera, konektora za bateriju, dva otpornika i ugradnog DB9 

konektora. Sve komponente korišćene u ovom projektu su Truough hole tipa, odnosno montiraju 

se na ploču provlačenjem kroz rupe. 
 
Princip rada ovog programatora je sledeći: PIC mikrokontroler koji želimo isprogramirati stavimo 

u 18-pinsko podnožje na pločici. Pločica je serijskim portom povezana sa računarom na kome se 

nalazi softver namenjen za programiranje mikrokontrolera tj. pločica je isprojektovana da 

predstavlja interfejs između mikrokontrolera i serijskog porta računara. Nakon programiranja, 

mikrokontroler se uklanja sa pločice programatora i postavlja u podnožje njegovog originalnog 

kola. U nastavku će biti opisani osnovni koraci u projektovanju štampane ploče ovog uređaja, 

korišćenjem softverskog paketa Altium Designer. 
 
 

2.1.2. Idejna skica električne šeme na papiru 
 

 
Kao i obično, sve počinje nacrtanom skicom uređaja na papiru, Slika 5. Na osnovu ove ilustrovane 

šeme potrebno je projektovati štampanu ploču. Otpornici RB6 i RB7 imaju vrednosti 22k i 2k2, 

respektivno, i futprint AXIAL-0.3, podnožje mikrokontrolera je DIP-18, a futprint DB9 konektora 

je DSUB1.385-2H9, dok je futprint konektora baterije HDR1X2. 
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Slika 5.  Idejna skica šeme uređaja 

 

 

2.1.3. Pokretanje Altium Designer-a i kreiranje novog projekta 
 

 
Kada se kreće sa postupkom projektovanja PCB-a, prvi korak je pokretanje programskog 

okruženja Altium Designer pomoću prečice na desktopu, ili preko start menija (ikonica sa nazivom 

Altium Designer.exe). Nakon toga potrebno je kreirati novi projekat, u kojem će biti objedinjeni 

svi fajlovi koji će biti kreirani tokom postupka projektovanja. Postupak kreiranja novog PCB 

projekta pomoću opcije File -> New -> Project prikazan je na Slici 6. Nakon toga, otvoriće se 

novi prozor u kome treba odabrati tip projekta (PCB), dati naziv projektu (PIC programator) i 

snimiti projekat na željenu lokaciju odabirom browse location, kao što je prikazano na Slici 7. 

Polje project template postaviti na Default. Preporučljivo je svaki novi projekat snimati u 

zaseban, za tu priliku kreiran folder na hard disku, kako bi bilo izbegnuto pravljenje „nereda“ 

nagomilavanjem fajlova koji pripadaju različitim projektima u istom folderu. U ovom slučaju, 

projektu će biti dodeljen naziv „PIC programator“ i biće snimljen u projektnom direktorijumu, pod 

nazivom PIC programator.PrjPcb (ekstenzija glavnog projektog fajla je “.PrjPcb”).  
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Slika 6.  Kreiranje novog projekta 

Slika 7.  Odabir tipa, naziva i lokacije projekta. 
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Nakon uspešnog kreiranja projekta, otvoriće se prazan radni prostor, kao i workspace panel u kome 

se vidi da je kreiran novi glavni projektni fajl sa ekstenzijom “.PrjPcb”. Svi projektni fajlovi koji 

budu naknadno kreirani unutar ovog projekta (a ovi fajlovi mogu biti Shematic fajlovi sa 

ekstenzijom .SchDoc, shematic library fajlovi sa ekstenzijom .Schlib, PCB library fajlovi sa 

ekstenzijom .PCBlib, i PCB fajlovi sa ekstenzijom .PCBDoc) biće prikazani u ovom workspace 

panelu pod karticom Projects, kao što je označeno na Slici 8. 
 
 

 
 

2.1.4. Kreiranje novog dokumenta u Schematic Editoru 
 

 
Nakon što je kreiran prazan projekat, u njega je potrebno dodati nov Schematic dokument, u kojem 

će biti nacrtana električna šema uređaja. Redosled koraka je sledeći: 
 

Opcijom File -> New -> Schematic dodajemo u projekat nov Schematic fajl nazvan  
Sheet1.SchDoc (Slika 9). 

Na Slici 10 je prikazano kako se ovaj schdoc fajl snima (desni klik na ikonicu Shematic-a i 
odabir Save) i time se ovaj fajl uvrštava u projekat. 

Slika 8.  Prikaz novokreiranog projekta, u kome se još uvek ne nalaze projektni fajlovi 
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Slika 9. Kreiranje shematic editora 

 

 

 

Slika 10.  Snimanje Shematic fajla: desni klik na ikonicu schDoc fajla -> Save (i davanje 
naziva shematic fajlu) 
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Nakon dodavanja praznog shematic fajla u projekat, neophodno je snimiti promene u projektni fajl 

(crveni indikator i simbol * se nalaze pored projektnog “.PrjPcb” fajla). Postupak snimanja 

prikazan je na Slici 11. Desni klik na ikonicu “.PrjPcb” fajla i odabir  na Save Project. 

 

 
 

Slika 11.  Snimanje promena u glavnom projektnom fajlu 
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Nakon ovih koraka, prozor je prikazan na Slici 12. Veći deo ekrana zauzima prazna radna površina 

Schematic Editora, na kojoj će biti nacrtana šema uređaja. Sa leve strane se vidi panel Projects u 

kojem se vidi koji projekti su trenutno otvoreni, zajedno sa hijerarhijom fajlova koji mu pripadaju. 

Takođe, označeno je koji fajl je trenutno aktivan (u ovom slučaju Sema.SchDoc). Zumiranje i 

odzumiranje pregleda u okviru glavnog prozora vrši se pritiskom na tastere Page Up i Page Down, 

ili zadržavanjem klika na Scroll tasteru miša i pokretom miša gore-dole.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 12.  Prazna radna površina Schematic Editora 

 
Pre početka crtanja šeme dobro bi bilo definisati dimenzije sheet-a na kome se crta šema (zavisno 

od toga koliko je projekat kompleksan), kao i podatke o samom projektu (Title, Number, Revision, 

Date, Project Location itd).  

Dimenzije radnog lista (sheet-a) se podešavaju klikom na padajući meni                                                 

Design->Document Opstions i odabirom kartice Sheet Options kao što je prikazano na Slici 13. 

U polju Standard Style može se odabrati jedan od dostupnih predefinisanih template-a, ili se može 

odabrati Custom Stzle, gde se ručno zadaje širina i dužina radne površine u pikselima. 
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Slika 13.  Document Options, podešavanje dimenzija radne površie, i definisanje parametara projekta 

Nakon podešavanje ovih dimenzija, klikom na karticu Parameters, kao što je prikazano na Slici 14, 

prelazi se u odeljak sa definisanim parametrima projekta, i dodeljivanjem njihovih vrednosti. U polja 

Value potrebno je uneti vrednosti parametara kao na Slici 14. 

Slika 14.  Dodavanje parametara i njihovh vrednosti 
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Pored standardnih paametara, moguće je dodati i nove parametre klikom na Add... i definisati 
njihove vrednosti. Nakon izmena, potrvrditi sa OK. 
 
 Kako bi vrednosti parametri koje smo uneli bili vidljivi kao stringovi kada unesemo nazive 
parametara, neophodno je omogućiti konverziju specijalnih stringova. Kliknuti na padajući meni 
Tools i odabrati Shematic Preferences. U polju Graphical Editing čekirati Convert Special 
String, i potvrditi sa OK, kao što je naznačeno na Slici 15. 
 

U donjem desnom uglu radne površine, nalaze se polja u koje treba uneti podatke o projektu (Title, 

Number, Revision…). Stringovi se dodaju klikom na padajući meni Place->Text String, a zatim 

se pre postavljanja string na odgovarjauće mesto na radnoj površini klikne Tab taster na tastaturi i 

u polje za tekst se unese naziv parametra, ispred koga se napiše znak = , kao što je prikazano na 

Slici 16. Ovo će omogućiti da se kao tekst pojavi vrednost (value) koja je dodeljena ovom 

parametru u prethodnom koraku. Ovaj postupak dodavanja parametara je potrebno ponoviti za 

ostala polja. Rezultat unošenja stringova je prikazan na Slici 17.  

  

 

 

 

Slika 15.  Konvertovanje specijalnih stringova 
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Slika 17. Parametri konvertovanih stringova 

 

2.1.5. Integrisane boblioteke sa komponentama 
 

Sa desne strane radnog okruženja nalazi se kartica sa dostupnim bibliotekama, koje sadrže 

komponente neophodne za crtanje šeme. Ukoliko ova kartca nije aktivna, potrebno je odabrati iz 

padajućeg menija View-> WorkSpacePannels-Szstem-Libraries, kao što je prikazano na Slici 18. 

Slika 16.  Unošenje stringova sa =naziv_parametara i postavljanje na radnu površinu 
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Slika 18. Biblioteke komponenti 

 

Pažljivim pogledom na skicu ranije prikazanu na Slici 5, moguće je primetiti da su za crtanje 

celokupne šeme PIC programatora potrebne samo 4 različite komponente: 
 

9-pinski konektor DB9 

Otpornik Res2 (2 komada) 

18-pinsko DIP podnožje za mikrokontroler  
Priključak za napajanje 

 
Da bi komponente mogle biti postavljene na radnu površinu, potrebno je pristupiti bibliotekama 

u kojima se one nalaze. Bibliotekama komponenti koje su u datom trenutku na raspolaganju
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moguće je pristupiti preko jezička Libraries. Klikom na ovaj jezičak, otvara se panel koji 
omogućava navigaciju i pretraživanje komponenti po dostupnim bibliotekama. Za početak, 
potrebno je obratiti pažnju na sledeće dve biblioteke2: 
 
Miscellaneous Devices.IntLib je biblioteka koja sadrži generičke komponente, koje se najčešće 

upotrebljavaju pri crtanju šeme uređaja (npr. otpornici, kondenzatori, diode, prekidači i sl.)  
 
Miscellaneous Connectors.IntLib sadrži standardne, najčešće korišćene konektore. 
 
 

2.1.6. Postavljanje komponenti 
 

 
U ovom koraku je potrebno iz biblioteke uzeti odgovarajuće komponente (odosno njihove 

simbole) i rasporediti ih po radnoj površini. U okviru panela Libraries, prvo je potrebno izabrati 

jednu od dostupnih biblioteka. Ispod naziva trenutno aktivne biblioteke nalazi se polje u kojem se 

definiše filter koji olakšava pronalaženje komponente u okviru biblioteke. U početku, u ovom polju 

se nalazi zvezdica3, što uključuje prikaz svih komponenti u okviru liste koja se nalazi ispod ovog 

polja. Filter se koristi u slučaju da je potrebno suziti kriterijum pretrage samo na komponente čije 

oznake sadrže određeni skup karaktera. Primer: ako upišemo filter Res*, u listi komponenti biće 

prikazane samo one čija oznaka počinje na “Res”. Nakon pronalaženja komponente na spisku u 

okviru biblioteke, klikom na naziv komponente se pojavljuje njen simbol ispod spiska komponenti. 

Klikom na taster Place (alternativno, dvostrukim klikom na naziv komponente, ili zadržavanjem 

klika na komponentu i prevlačenjem na radnu površinu) ona se ”prenosi“ do radne površine u 

glavnom prozoru. Svakim sledećim pritiskom na levi taster miša u šemu će biti postavljena po 

jedna kopija komponente (sa inkrementovnom oznakom). Ova operacija se prekida klikom na 

desni taster miša, ili pritiskom tastera Esc na tastaturi. 
 
Pre samog postavljanja simbola komponente na radnu površinu, moguće je vršiti izmene vezane 

za njenu orjentaciju, atribute i sl. dok je ona još „u vazduhu“, pritiskom na sledeće tastere: 
 

Razmak (Space) rotira simbol komponente za 90 stepeni.  
X preslikava simbol komponente osno simetrično u odnosu na X osu 

Y preslikava simbol komponente osno simetrično u odnosu na Y osu 

Tab otvara dijalog za izmenu atributa komponente (oznaka, vrednost, futprint i sl.) 
 
Simbol konektora za serijsku komunikaciju nalazi se u biblioteci Miscellaneous 

Connectors.IntLib, pod nazivom D Connector 9. Nakon selektovanja komponente, rotiramo je 

pritiskom na Space i postavljamo na radnu površnu kao što je prikazano na slici 19. 
 
 
1 U prethodnom poglavlju je rečeno da postoje biblioteke simbola komponenti (sa ekstenzijom 
.SchLib) i biblioteke futprintova (sa ekstenzijom .PcbLib). Međutim, postoje i integrisane 
biblioteke koje nose ekstenziju .IntLib i koje istovremeno sadrže i simbole i futprintove 
komponenti. 
2 U okviru filtra, karakteri * i ? predstavljaju “džokere“, pri čemu upitnik zamenjuje jedan, a 
zvezdica proizvoljan broj karaktera u načivu komponente. 
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Slika 19.  Postavljanje simbola konektora DB9 za serijsku komunikaciju sa računarom 

 
U istoj biblioteci se nalazi i simbol koji će biti iskorišćen za konektor za napajanje. Njegov naziv 

je Header 2. 
 
Simboli otpornika nalaze se u biblioteci Miscellaneous Devices.IntLib. Od postojećih simbola, 

izabraćemo onaj pod nazivom Res2 i postaviti 2 otpornika na radnu površinu. Izgled radne 

površine nakon postavljanja konektora za napajanje i otpornika prikazan je na Slici 20. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Slika 20.  Radna površina, nakon postavljanja konektora za napajanje i otpornika 
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2.1.7. Kreiranje novih komponenti 
 

 
Ovde će biti ilustrovan postupak kreiranja nove komponente koju definiše korisnik, na primeru 

18-pinskog podnožja za mikrokontroler. Pošto svaka komponenta mora da pripada nekoj 

biblioteci, ukoliko postoji potreba za kreiranjem korisničkih komponenti, one se priključuju novoj 

biblioteci koja se definiše u okviru projekta. Kada su jednom definisane, ove komponente mogu 

biti korišćene u i drugim projektima uključivanjem biblioteke u njih. Ovo uključivanje se vrši 

odabirom na padajući meni Design-ADD/Remove Library (Slika 21), a zatim klikom na Add ili 

na Remove u zavisnosti da li korisnik želi da doda ili ukloni biblioteke iz projekta. 

 
Slika 21.  Dodavanje i uklanjanje postojećih biblioteka iz projekta 

 

 Za kreiranje nove šematske biblioteke potrebno je odraditi sledeće: 
 

Korišćenjem opcije File -> New -> Library -> Schematic Library kreiramo novu 

biblioteku koja je priključena projektu i ima generički naziv SchLib1.SchLib . 

Korišćenjem opcije File -> Save snimamo biblioteku u projektni folder, dodeljujući joj 

pri tome novo ime Komponente.SchLib . 
 
Kada je nova biblioteka kreirana, u donjem levom uglu ekrana se pojavljuje novi jezičak “SCH 

Library”. Klikom na njega, sa leve strane ekrana se otvara panel koji omogućava navigaciju kroz 

biblioteku. U početku biblioteka sadrži samo jednu komponentu generički nazvanu 

Component_1. Dvostrukim klikom na komponentu, otvara se dijalog kojim se određuju atributi 

komponente. Potrebno je izvršiti sledeće promene (Slika 22):  
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Slika 22.  Određivanje atributa komponente 

U polju Default Designator upisujemo IC? Na ovaj način svaki put kada ta komponenta bude 

instancirana, u okviru šeme dobija generički naziv IC? Dalje, u postupku zvanom anotacija (koji 

će biti detaljnije opisan), upitnik u nazivu svake od komponenti se zamenjuje brojem, čime se 

postiče neophodno svojstvo da svaka komponenta na šemi ima jedinstven naziv.  
U polju Default Comment upičemo komentar koji korisniku biblioteke pobliže objašnjava o 

kakvoj se komponenti radi. U ovom slučaju to može biti npr. “Podnozje za PIC kontroler”. Da 

ovaj komentar ne bi nepotrebno opterećivao prikaz komponente u okviru šeme, možemo isključiti 

opciju Visible za ovaj komentar.  
U polju Symbol Reference upišemo Podnozje_18, čime određujemo naziv komponente u okviru 

biblioteke. 

U polju Parameters klikom na Add možemo opciono dodavati parametre koje definiše proizvošač 

komponente u datasheet-u.  
 
Sledeći korak je definisanje izgleda simbola komponente u glavnom prozoru. Simbol obično 

sadrži: 
 

Geometrijske simbole koji asociraju na fizički izgled i funkcionalnost 

komponente.  

Nožice (pinove), preko kojih se komponenta povezuje u električno kolo. 

Tekstualne oznake, koji pobliže opisuju funkcionalnost komponente i/ili pinova. 
 
U ovom slučaju, potrebno je nacrtati simbol podnožja za integrisano kolo koje se proizvodi u 

standardnom kućištu zvanom DIPx, ili alternativno DILx (Dual In-line Package). Kod ovakvih 

integrisanih kola, obično postoji marker (udubljenje na kućištu, nacrtana tačka i sl.) koji označava 

njihovu orjentaciju, kao što je prikazano na Slici 23. Numeracija pinova kreće od pina br. 1 koji 

se nalazi u gornjem levom uglu dalje se nastavlja u krug u smeru suprotnom od kazaljke na satu. 
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Slika 23.  Pinovi kućišta DIP18 (odnosno DIL18) 

 
Imajući ovo u vidu, nacrtaćemo odgovarajući simbol. Prvi korak je dodavanje pinova korišćenjem 

opcije Place -> Pin. Dok je pin još u “vazduhu”, pritiskom na Tab otvara se dijalog kojim se zadaju 

svojstva pina: 
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Display name služi za zadavanje naziva pina koji je obično vezan za njegovu funkciju 

(npr. Vcc, GND, RESET, TxD, P2.5, XTAL i sl.)4. Dozvoljeno je da u okviru iste 

komponente više različitih pinova imaju isti naziv. U ovom slučaju stavićemo da oznaka 

prvog pina bude 1 i ostavićemo da opcija Visible bude uključena.  
Designator predstavlja jedinstvenu (obično numeričku) oznaku pina. Opet, u slučaju 

prvog pina ostavljamo da ova oznaka bude 1, ali isključujemo opciju Visible da ne bi 

došlo do dupliranja teksta, pošto se u ovom slučaju ime i oznaka pina poklapaju. 
 
Pre postavljanja pina, potrebno je obratiti pažnju još i na njegovu orjentaciju. Svaki pin ima dva 

kraja (24): 
 
“Vruć kraj” je onaj kraj preko kojeg se pin povezuje u električno kolo i koji treba da bude 

orjentisan “ka napolje”. Prepoznaje se po krstiću nalik na slovo X. 

“Hladan kraj” se orjentiše ka unutrašnjosti simbola komponente. Ime/oznaka komponente se 

ispisuje sa ove strane. 
 
 
 
 
 
 
 
 
 
 
 
 

 
Slika 24.   “Vruć” i “Hladan” kraj pina komponente 

 
Imajući u vidu orjentaciju pinova i fizički izgled komponente, postavljamo redom jedan ispod 

drugog pinove 1-9 na radnoj površini, klikom na levi taster miša. Kada je pin postavljen, ime i 

oznaka sledećeg pina se automatski inkrementiraju, tako da nije neophodno stalno podešavanje 

atributa za svaki pin ponaosob. Nakon postavljanja pina br.9, potrebno je zarotirati pin br.10 za 

180 stepeni pomoću dvostrukog pritiska na taster Space, a zatim ga postaviti sa druge strane tela 

komponente (koje će naknadno biti nacrtano), naspram pina br. 9 i dalje nastaviti naviše do pina 

br.18. Postavljanje pinova se zaustavlja pritiskom na taster Esc. 
 
Nakon postavljanja pinova ostaje još da se nacrta telo komponente, koričćenejm opcije Place -> 

Rectangle. Pri ovome će prikaz naziva pinova nestati, pošto će ih pravougaonik pokriti. Ovaj 

problem se rešava dvostrukim klikom na pravougaonik, čime se otvara dijalog kojim se zadaju 

njegova svojstva. Uključivanjem opcije Transparent pravougaonik postaje providan, a samim tim 

nazivi pinova postaju ponovo vidljivi. Krajnji izgled simbola komponente prikazan je na slici 25.  
 
4 Ukoliko digitalni pin radi u inverznoj logici (aktivan je na logičku nulu), obično je poželjno da 
njegov naziv bude nadvučen. Ovo se postiže dodavanjem obrnute kose crte (backshasl) ispred 
svakog karaktera u nazivu za koji želimo da bude nadvučen. Primer: \R\E\S\E\T 
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Slika 25.  Krajnji izgled simbola podnožja PIC mikrokontrolera 

 
Kada je komponenta nacrtana, najbolje bi bilo pomeriti je u centar (presek dvaju osa na radnoj 

površini), kako bi se prilikom pomeranja ove komponente na šemi ona prikazala na mestu klika. 

Pomeranje se vrši selektovanjem svih segmenata komponente i njihovim prevlačenjem na 

odgovarajuće mesto. Ukoliko je komponenta suviše ofsetovana u odnosu na centar, taj offset bi se 

odrazio “bežanjem” komponente svaki put kada bi se na šemi/PCB-u komponenta pokušala 

pomeriti. Poravnata komponenta sa centrom je prikazana na Slici 26.  

 
Slika 26.  Postavljanje komponente što bliže centru 
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Pošto je komponenta uspešno kreirana, spremna je za postavljanje na radnu povrsinu Schematic 

Editora, ali je najpre potrebno ažurirati ove izmene vraćanjem na karticu Projects, i odabirom na 

Save (Slika 27). 

 
Slika 27.  Snimanje izmena u šematik biblioteci 

Ukoliko su vršene izmene na komponentama koje su već postavljene na šematiku, ovakav vid 

čuvanja izmena neće biti dovoljan da obuhvati već postavljene komponente, nego će važiti samo 

za komponente koje će naknadno biti postavljane. Da bi se omogućilo da i već postavljene 

komponente poprime nove izmene na komponenti, potrebno je vratiti se u karticu SCH library i 

desni klikom na komponentu odabrati Update Shematic Sheet, kao što je prikazano na Slici 28. 
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Slika 28. Update-ovanje već postavljene komponente na šemi 

Kreirana komponenta se postavlja na radnu površinu klikom na opciju Place, a nalazi se u 

novosačuvanoj biblioteci Komponente.SchLib (Slika 29). 

 
Slika 29.  Postavljanje nacrtane komponente na radnu površinu Shematic Editora 
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Slika 31.  Automatska anotacija 

 

2.1.8. Dodavanje i označavanje komponenti (anotacija) 
 

 
Nakon što su komponente postavljene na radnu površinu Schematic Editora (Slika 30 levo), 

potrebno je komponentama dodeliti jedinstvene oznake, u procesu koji je poznat kao anotacija. U 

ovom slučaju imamo dva identična otpornika sa istom oznakom (R?) koji se stoga nalaze u 

“konfliktu” i softver ih automatski označava crvenom talasastom linijom ispod simbola otpornika. 

Konflikt se može razrešiti na dva načina. Prvi način je “ručna” promena oznaka korišćenjem 

dijaloga za dodelu atributa komponenti, koji se otvara dvostrukim klikom levog tastera miša na 

komponentu. Primenićemo ovu strategiju, da bismo postigli da oznake komponenti odgovaraju 

onima na polaznoj šemi na slici 5. Naravno, usput je moguće korišćenjem istog dijaloga promeniti 

i vrednosti otpornika (menjamo polje Value kod RB7 sa 1K na 2K2 i kod RB6 sa 1K na 22K). 

Nakon ovog koraka dobijamo izgled šeme koji je prikazan na Slici 30 (desno). 

Slika 30.  Radna površina nakon postavljanja komponenti (levo) i nakon anotacije (desno) 

Drugi način za dodeljivanje jedinstvenih oznaka je korišćenjem alata za automatsku anotaciju. Ovo 

je naročito zgodno kod većih šema, u slučaju kad nije bitno da komponente imaju unapred 

određene oznake. Opcija Tools -> Anotation -> Annotate Schematics otvara dijalog u kojem se 

podešavaju parametri anotacije (Slika 31). Ovaj alat redom zamenjuje znak pitanja u oznakama 

komponenti brojevima. Opcija Order of Processing određuje strategiju anotacije, kada je u 

pitanju redosled dodele brojeva. Klikom na Update Changes List, alat formira listu predloženih 

promena u oznakama komponenti. Ako je korisnik zadovoljan predloženim promenama, klikom 

na Accept Changes se pokreće proces automatske anotacije.  
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Ukoliko se iz nekog razloga na šemi nalaze komponente sa duplikatima u nazivu (slučajno postoje 

dve komponente koje se isto zovu, a problem je nastao kopiranjem jedne komponente), ovo se 

može ukloniti odabirom na Tools-Annotation-Reset Duplicate Shematic Designators. U ovom 

slučaju će se duplirana komponenta vratiti na oznaku ?. Npr. Ako su postojala dva otpornika sa 

ozakama R1, nakon resetovanja dupliranih oznaka, jedan otpornik će zadržati oznaku R1, dok će 

drugi dobiti oznaku R?. Još jedan način za automatsko dodeljivanje anotacije na celoj šemi je 

moguć odabirom na: Tools-Annotation-Annotate Shematic Quietly.  

Takođe, automatski je moguće i obrisati sve oznake sa komponenti, tj. vratiti sve u početno stanje 

R?, IC? itd… odabirom na Tools-Annotation-Reset Shematic Designators. 
 

2.1.9. Poravnanje komponenti na šematiku 
 
Kada je potrebno poređati više komponenti na šematiku da se nalaze jedna ispod druge (kao što je 

to slučaj sa otpornicima RB6 i RB7), može se koristiti opcija za automatsko poravnanje, ali se tom 

prilikom moraju selektovati sve komponente na koje se želi primeniti ova opcija. Selektovanje 

više komponenata vrši se zadržavanjem tastera SHIFT i klikom na željene komponente. 

Kada su sve komponente selektovane, desnim tasterom miša na jednu od selektovanih komponenti 

odabira se opcija Align, pa se odabere odgovarajuće poravnanje. Na Slici 32 biće izabrano 

poravnanje Align Left (prečica je CTRL+SHIFT+L), i to će kao rezultat dati ravnanje svih 

selektovanih komponenti prema onoj (u selektovanom nizu) koja je po X osi najbliža 

koordinatnom početku (defautlna vrednost: donji levi ugao na shematiku). Na sličan način može 

se izvršiti i poravnanje Align Right (prečica je CTRL+SHIFT+R), Align Top (prečica je 

CTRL+SHIFT+T) i Align Bottom (prečica je CTRL+SHIFT+B).    

 
Slika 32. Opcija za automatsko poravnanje niza selektovanih komponenti 
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2.1.10. Odabir Grid-a na šematiku 
 
Da bi se definisala rezolucija prilikom pomeranja komponenata (ili povlačenja žica) na šematiku, 

koristi se opcija Snap Grid. Najjednostavniji način za postavku Grida je da se na praznom polju 

šematika klikne desni taster miša, i odabere Grid-Set Snap Grid. Default vrednsot Grid-a je      

10mil-a, a smanjivanjem ove vrednsotsi omogućiće se preciznije pomeranje komponenti na radnoj 

površini Shematic Editora. 

 

 
Slika 33. Postavljanje Grid-a 

 

2.1.11. Povezivanje pinova komponenti 
 

 
Međusobno povezivanje komponenti se vrši preko “vrućih” krajeva njihovih pinova, kao što je 

već napomenuto. Ukoliko dva ili više pinova komponenti trebaju da budu spojeni u električnom 

smislu (tj. treba da postoji provodna veza koja ih povezuje na štampanoj ploči), kaže se da ti pinovi 

pripadaju istom Net-u. Ovaj pojam je ekvivalentan pojmu čvora u teoriji električnih kola, koji 

podrazumeva tačke koje su na istom potencijalu. Povezivanje pinova, tj. njihovo pridruživanje 

istom Net-u može biti postignuto na više načina, koji će upravo biti demonstrirani. 
 
Prvi način je korišćenjem alata za ožičavanje, koji je moguće aktivirati na sledeće načine: 
 

Opcija Place -> Wire u glavnom meniju.  
Klik na ikonicu Place Wire u paleti sa alatima, kao što je prikazano na Slici 34. 
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Slika 34.  Korišćenje alata za ožičavanje 

 
U oba slučaja kursor će promeniti oblik u krstić što znači da možemo početi sa “ožičavanjem“. 

Postavljanjem kursora u polaznu tačku i potom klikom na levi taster miša započinje postavljanje 

jedne električne veze. Promena pravca kretanja se postiže ponovnim klikom na isti taster, čime se 

“lomi“ linija. Ako u toku povlačenja veze pritisnemo taster Delete na tastaturi, biće obrisan 

poslednji pravolinijski segment. Kada je postavljen i poslednji segment jedne veze, prekidamo je 

klikom na desni taster. Posle ovoga, alat za ožičavanje je i dalje aktivan tako da je moguće nastaviti 

sa povezivanjem drugih komponenti. Proces električnog povezivanja komponenti prekida se još 

jednim klikom na desni taster miša, ili pritiskom na taster Esc. 
 
Prilikom povezivanja komponente žicom program sam signalizira korisniku gde je “vruć“ kraj 

pina simbola komponente odnosno gde će se povezivanjem komponente i žice napraviti električni 

kontakt. U tom slučaju prevlačenjem žice preko pina simbola pojavljuje se krug u centru kursora. 

U tom trenutku završava se postavljanje žice. 
 
Izmene na već postavljenoj vezi mogu se vršiti klikom na nju i “odvlačenjem“ veze na novu 

poziciju čime se menja njen oblik. Takođe, moguće je obrisati celu vezu njenim selektovanjem 

držeći taster SHIFT i sukcesivnim selektovanjem segmenata veze, pa naknadnim pritiskom na 

taster Delete. 
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Pri ožičavanju je potrebno posebno voditi računa o ukrštanjima veza. U slučaju veza koje se 

ukrštaju i koje pripadaju istom netu (odnosno kod kojih postoji električni spoj), mesto ukrštanja je 

obeleženo tačkom. U suprotnom, kada linije pripadaju različitim netovima, ukrštanje je 

predstavljeno bez tačke (Slika 34). 

 

2.1.12. Promena šablona povlačenja žica 
 
Pored podrazumevanog šablona postavljanja žice pod pravim uglom, moguće je odabrati i tzv. 

45 agle šablon, ili any angle šablon. Ova promena šablona se vrši kada se jedan kraj žice fiksira 

na radnoj površini, a zatim se klikom na SHIFT+SPACE ciklično prelazi na jedan od opisanih 

modova. Ova promena će ostati zapamćena za sledeća povezivanja. Slika 35 prikazuje postavljenu 

žicu u any angle modu. 

 
Slika 35.  “Any Angle” povezivanje 

 

Drugi način međusobnog povezivanja pinova je pomoću oznaka netova (net label). To će biti 

pokazano na primeru spajanja pina 3 konektora serijskog porta i pina 4 podnožja za mikrokontroler 

(Slika 36). Net kome pripadaju ovi pinovi ćemo nazvati MCLR, kao što je označeno na slici 1.1. 

Pridruživanje pinova netu se vrši opcijom Place -> Net Label, ili pritiskom na ikonicu Place Net 

Label u paleti sa alatima. Kursor se pretvara u krstić pored kojeg je napisan naziv neta. Ovaj naziv 

je moguće promeniti “u letu“ pritiskom na Tab, ili nakon postavljanja, dvostrukim klikom na net 

labelu. Nakon promene naziva, postavljamo net labelu tako da se kursor poklopi sa “vrućim“ 

krajem pina 3 konektora serijskog porta5 i ponovimo postupak za pin 4 podnožja mikrokontrolera. 

Ovaj način spajanja je u električnom smislu ekvivalentan ožičavanju i specifičan je po tome što  
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omogućava eksplicitno dodeljivanje naziva netovima. Još jedna pogodnost koju nosi sa sobom je 

što smanjuje broj žica na radnoj površini, čime omogućava bolju preglednost šeme.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 36.  Povezivanje pinova pomoću net labela 

 
Posebna vrsta net labela su portovi za napajanje (Power Port), npr. izvor jednosmernog napona 

napajanja (Vcc) i masa (GND). Pošto su ovi netovi obično distribuirani ka velikom broju pinova 

komponenti, njima se pridaje posebna važnost, tako da imaju i posebne grafičke oznake. 

Korišćenjem ovih oznaka uveliko se poboljšava preglednost šeme. Postavljaju se na radnu 

površinu opcijom menija Place -> Power Port, ili klikom na odgovarajuću ikonicu u paleti sa 

alatima. Slika 37 prikazuje konačni izgled šeme, nakon dodavanja portova za napajanje.  
 
 
 
5 Na slici je iz estetskih razloga pin 3 konektora serijskog porta “produžen“ dodavanjem 
segmenta linije u dužini net labele. 

Slika 37.  Konačni izgled šeme 
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2.1.13. Prevlačenje komponenti zajedno sa postavljenim žicama 
 
Ukoliko postoji potreba da se već povezana komponenta / ili segment šeme pomeri na drugo mesto 

na radnoj površini, to je moguće učiniti bez brisanja postojećih žica ponovnog ožičavanja na drugoj 

lokaciji. Naime, pritiskom i zadržavanjem tastera CTRL, željena kompoeneta se može pomeriti na 

novo mesto u šematiku, bez njenog odvajanja od postojećih vodova na njenim pinovima. Slična 

konstatacija važi se može primeniti i na segment šeme, samo se prilikom selektovanja mora 

zadržati taster SHIFT. 

 

2.1.14. Kompajliranje šematika 
 
 
Nakon povezivanja komponenti, pre prelaska na PCB, potrebno je proveriti da li postoje određena 

upozorenja ili greške na šemi, koje bi mogle uticati na funkcionalnost. Ova provera se vrši 

kompajliranjem šematika, odabirom na: Project iz padajućeg menija, i selektovanjem Compile 

Document *.*.SchDoc, kao što je prikazano na Slici 38. Da bi se sagledale greške i upozorenja, 

nakon odabira na Compile, neće se automatski otvoriti prozor sa porukama, već je potrebno ručno 

ga pokrenuti iz liste padajućeg menija View: View-Workspace Panels-System-Messages 

(Slika 39). 

 
Slika 38.  Kompajliranje šematika 
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Slika 39. Aktiviranje prikaza poruka kompajlera 

Sa Slike 40 jasno možemo videti da na šemi postoji jedan konflikt (u našem slučaju namerno 

izazvan brisanjem oznake sa konektora napajanja) kako bi bio demonstriran prikaz upozorenja. 

 
Slika 40. Upozorenja i greške 

Nakon ponovnog vraćanja oznake na konektor napajanja, ponovljeno je i kompajliranje, a rezultat 

uspešnog kompajliranja bez upozorenja je prikazan na Slici 41.  
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Slika 41. Rezultat uspešnog kompajliranja 

2.1.15. Označavanje pinova komponenti koji se ne povezuju na šemi 
 
Pinovi koji se ne koriste prilikom povezivanja šeme, mogu se označiti sa objektom NO ECR, koji 

se nalazi u paleti osnovnih alata za povezivanje a prikazan je krstom crvene boje (Slika 42). 

Slika 42.  NO ECR objekat 
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Ovo se koristi da bi se potisnule moguće prijave upozorenja nakon provere pravila električnog 

povezivanja. Pored nepovezanih pinova, ovo se može dodati na mestima gde je potrebno namerno 

ograničiti proveru grešaka u određenoj tački kola.  

 

2.1.16. Označavanje net labela ili žica markerom radi bolje preglednosti 
 
Upotrebom alata Net Colors koji se nalazi u paleti i ima izgled markera može se ofarbati određeni 

Net, bilo da se radi o labeli ili o žici (vodu). Na Slici 43 je prikazan primer obojenih vodova 

otpornika RB6, RB7, kao i labele MCLR upotrebom ove opcije. Ovo nije neophodno raditi sa 

većinom vodova, ali ponekad može da bude korisno ukoliko je potrebno istaći neke Net-ove. 

Markeri će se videte i na PCB-u. Kombinacija tastera CTRL+SHIFT+C uklanja postavljene 

markere. 

 

 
Slika 43.  Označavanje Net-ova color markerom 

 

2.1.17. Pojam “Futprint-a” komponente 
 

 
Kao što je već rečeno u uvodu, futprint (“otisak stopala“) predstavlja fizičku reprezentaciju 

komponente na štampanoj ploči, pri čemu broj, raspored i fizičke dimenzije lemnih mesta 

odgovaraju realnim fizičkim dimenzijama komponente. Definisanje futprinta komponente je prvi 

korak ka prelasku iz apstraktnog sveta šeme uređaja u fizički svet štampane ploče. Jedna 

komponenta se može pojaviti u više različitih futprintova u zavisnosti od toga da li je through-hole 

ili SMD, kao i u zavisnosti od proizvođača, tehnologije proizvodnje, električnih parametara i sl. 

Stoga je neophodno voditi računa o tome da svakoj komponenti bude dodeljen futprint koji 

odgovara njenom fizičkom obliku. 
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Pre objašnjenja oznaka futprintova komponenti, sledi objašnjenje jedinica mere koje se koriste u 

Altium Designeru. Pošto se početni razvoj elektronskih komponenti uglavnom odigrao u SAD, 

nametnut je imperijalni (britanski) sistem mernih jedinica kojim se oni uobičajeno koriste. 

Kuriozitet je da je i sama Velika Britanija u međuvremenu usvojila metrički sistem kao zvanični, 

ali se imperijalni sistem i dalje održava u Americi. Usled toga, osnovna jedinica dužine je hiljaditi 

deo inča koji se naziva mil. Sledi nekoliko primera konverzije između metričkih i imperijalnih 

jedinica: 
 

1 inč = 1000 mil = 25.4 mm 100 mil = 2.54 mm 300 mil = 7.62 mm 
 
 

2.1.17.1. Futprint otpornika 
 
 
AXIAL-0.4 je najčešće korišćen futprint kada su u pitanju through-hole otpornici. Kao što je ranije 

napomenuto, deo naziva AXIAL sugeriše da je otpornik montiran aksijalno na štampanu ploču, 

odnosno da je telo komponente paralelno sa pločom. Broj 0.4 u nazivu označava da je udaljenost 

između lemnih tačaka (padova) 400 mil. Standardnom otporniku snage 0.25W takođe odgovara i 

AXIAL-0.3 futprint, ali je pri tom nožice otpornika potrebno saviti odmah nakon izlaska nožica 

iz tela otpornika podvrgavajući ih tako većem mehaničkom naprezanju. Izgled AXIAL-0.4 

otpornika prikazan je na Slici 44. 
 
 
 
 
 
 
 
 
 
 

Slika 44.  Aksijalni način montaže otpornika (levo) i futprint AXIAL-0.4 (desno) 

2.1.17.2. Futprint konektora za napajanje 
 

 
Za razliku od aksijalnog, postoji i radijalni način postavljanja otpornika, što je ređi slučaj, ali se 

koristi onda kada je zbog ograničenog prostora potrebno gušće spakovati komponente na štampanu 

ploču. U ovom projektu ne radi se o uspravno postavljenom otporniku, već će se ovaj footprint 

iskoristiti za konektor napajanja (Slika 45 u sredini), sa šematskom oznakom HDR1X2. U 

standardnim bibliotekama postoji još jedan futprint istih dimenzija, koji nosi oznaku RAD-0.1, ili 

RAD0.1, u zavisnosti od verzije softvera koja se koristi. Brojna oznaka 0.1 označava da je razmak 

između padova 100 mil.  
 
 
 
 
 
 
 
 
 
 
 

Slika 45.  Radijalno postavljen otpornik (levo), konektor napajanja (sredina) i futprint (desno) 
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2.1.17.3. Futprint konektora za serijsku komunikaciju 

 

 
Konektor za DB-9 je standardni konektor na koji se povezuje 9-pinski kabel za serijsku RS232 

komunikaciju. Oznaka futprinta komponente je DSUB1.385-2H9 (slika 46). 
 

 
Slika 46.  Futprint konektora za serijsku komunikaciju 

 

2.1.17.4. Futprint podnožja PIC mikrokontrolera 
 

 
Trenutno, sve komponente osim podnožja mikrokontrolera imaju dodeljen podrazumevani 

(default) futprint koji odgovara izgledu i dimenzijama komponenti. Dakle, potrebno je još dodeliti 

futprint podnožju kontrolera. Dodela futprintova vrši se na šematiku u istom dijalogu u kojem se 

dodeljuju ostali atributi komponente i koji se otvara dvostrukim klikom na komponentu, ili 

alternativno desnim klikom na komponentu i odabrirom sekcije Properties. Nakon otvaranja 

dijaloga, u sekciji Models kliknemo na taster Add i izaberemo opciju Footprint, kao što je to 

prikazano na Slici 47. 

 
Slika 47.  Dodavanje futprinta komponenti 
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 U polju Name dijaloga PCB Model upišemo DIP-186. Ukoliko je u polju PCB Library izabrana 

opcija Any, program će automatski pretražiti trenutno dostupne biblioteke da bi u njima pronašao 

futprint sa naznačenim imenom i pronaći će ga u biblioteci Miscellaneous Devices.IntLib, nakon 

čega će se u delu Selected Footprint pojaviti grafički prikaz izabranog futprinta. Nakon toga, 

izbor futprinta se potvrđuje klikom na taster OK (Slika 48). 

  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Slika 48.  Dodela futprinta podnožju PIC mikrokontrolera 

U tabeli 1 dat je prikaz svih komponenti korišćenih u ovom projektu i njihovih atributa. 
 

Tabela 1. Korišćene komponente i njihovi atributi 
 

Komponent
a Simbol Biblioteka 

 
Design

ator   
Part 
Type   Footprint  Biblioteka 

futprinta 
 

 (oznaka
) 

  (vredno
st) 

  
(kućište) 

  
           
  

Miscellaneous 
         

Miscellaneous 
 

Otpornik 1 Res2 

 
RB6 

 
22K 

  
AXIAL-0.4 

  

Devices.IntLib 
     

Devices.IntLib 
 

            

Otpornik 2 Res2 
Miscellaneous  

RB7 
 

2K2 
  

AXIAL-0.4 
 Miscellaneous  

Devices.IntLib 
     

Devices.IntLib 
 

            

Konektor 
D Connector 

9 
Miscellaneous  

J1 - 
  

 
  Miscellaneous  

Connectors.Int
Lib 

   DSUB1.385-
2H9 

 Connectors.IntLi
b 

 
           
  

Komponente.S
ch 

         
Miscellaneous 

 

Podnožje 
Podnozje 
DIL18 

 
IC1 - 

  
DIP-18 

  

Lib 
    

Devices.IntLib 
 

            

Napajanje Header 2 
Miscellaneous  Napaja

nje 
 

5V 
  

HDR1X2 
 Miscellaneous  

Connectors.Int
Lib 

     Connectors.IntLi
b 

 
             

 
  



49 
 

6Veliki broj integrisanih kola koristi futprint sa oznakom DIPx (Dual In-line Package), gde x 
označava broj pinova, što može biti npr. 8, 14, 28, 32 pa i preko 40. Razmak između uzastopnih 
pinova kod ovakvih kućišta iznosi 100 mil tj. 2,54 mm. 
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2.2.VEŽBA 1 b) Projektovanje štampane ploče PIC programatora u PCB 
Editoru 

 

2.2.1. Kreiranje novog dokumenta u PCB Editoru 
 
 
Do sada je opisan postupak crtanja šeme PIC programatora u Šematik Editoru 

(Pic_Programator.SchDoc). Iz tog virtuelnog (šematskog) sveta neophodno je preći u svet fizičke 

predstave štampane ploče, tj. PCB svet. Stoga je neophodno dodati u projekat novi, dokument sa 

“.PcbDoc” ekstenzijom u kojem će biti definisan izgled štampane ploče uređaja: 
 

Opcijom File -> New -> PCB dodajemo u projekat novi PCB fajl nazvan PCB1.PcbDoc  
Korišćenjem opcije File -> Save snimamo PCB dokument u projektni folder, dodeljujući 

mu pri tome novo ime PIC_Programator.PcbDoc. 

 
 

2.2.2. Učitavanje komponenti iz Schematic Editora 
 

 
Radna površina u PCB Editoru je prazna i spremna za učitavanje futprintova komponenti unetih u 

Schematic Editoru (Slika 49). 

 
Slika 49.  Prikaz praznog PCB dokumenta 

 Pre toga je potrebno snimiti Šematik dokument (Sema.SchDoc). Učitavanje futprintova 

komponenti u PCB dokument moguće je izvršiti na dva načina7: 
 

Ukoliko je trenutno aktivan PCB dokument, opcijom Design -> Import Changes From  
Pic_Programator.PrjPcb  
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Ukoliko je trenutno aktivan Schematic dokument, opcijom Design -> Update PCB  
Document Pic_Programator.PcbDoc 

 
U oba slučaja otvara se dijalog koji pokazuje promene koje moraju biti izvršene kako bi se 

oznake, futprintovi i netovi u PCB editoru poklapale sa onima u Schematic editoru (Slika 50). 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 50. Promene koje se vrše pri učitavanju komponenti u PCB Editor 
 
 
7 Isti postupak se primenjuje svaki put kada je tokom projektovanja ploče potrebno izvršiti 

izmene u Shematic Editoru  
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Ukoliko su svi prethodni koraci bili uspešno završeni, klikom na taster Validate Changes, po 

poljima u vrsti Check (Slika 50) se pojavljuju zeleni simboli koji označavaju da je sve u redu. 

Nakon toga, klikom na taster Execute Changes se komponente učitavaju u PCB dokument. Izgled 

ekrana PCB Editora nakon ovih koraka je prikazan na slici 51. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 51.  Radna površina PCB Editora nakon učitavanja komponenti 

 
Dakle, nakon učitavanja komponenti, na radnoj površini PCB editora se nalaze futprintovi 

komponenti, zajedno sa njihovim oznakama. Pinovi komponenti koji su međusobno povezani 

(odnosno koji pripadaju istim netovima) su povezani tankim sivim linijama, čime se korisniku daje 

do znanja između kojih pinova moraju biti postavljene provodne veze. Ove sive linije će nestati 

kada na tim mestima budu postavljeni provodni vodovi koji spajaju komponente. Treba primetiti 

i to da ukoliko su na šemi neki netovi obojeni markerima (kao što je objašnjeno u odeljku 2.1.16) 

ove oznake (po bojama) će biti zadržane I na PCB-u. Zbog toga na Slici 50 imamo pinove 

otpornika RB7 obojeno Zeleno, pinove otpornika RB6 crveno, a pinove sa labelom MCLR plavo. 

 
 

2.2.3. Razmeštanje komponenti i priprema za rutiranje 
 
Nakon što su futprintovi komponenti učitani u PCB editor, prelazi se na sam postupak 

projektovanja štampane ploče. Taj postupak podrazumeva dva ključna koraka: 

Raspoređivanje futprintova komponenti po površini ploče (engl. placement). 

Izvlačenje provodnih veza (rutiranje, engl. routing). 
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Tokom projektovanja, potrebno je imati na umu pravila o kojima je već bilo reči u uvodu, u sekciji 

1.2.2 Smernice i pravila vezana za projektovanje štampane ploče. Takođe, potrebno je voditi i 

računa o specifičnostima samog uređaja. U ovom slučaju, na primer, neophodno je komponentu 

konektora za serijsku komunikaciju (J1) postaviti na ivicu ploče i orjentisati sam konektor ka 

spoljašnjisti, kako bi bilo olakšano priključivanje kabla za serijsku vezu. 
 
Pre samog raspoređivanja futprintova, korisno je podesiti radnu površinu PCB Editora na način 

koji olakšava proces raspoređivanja. Korišćenjem opcije Design -> Board Options otvara se 

dijalog kojim se definišu opcije vezane za prikaz ploče u PCB editoru. Opcija Measurement Unit 

određuje da li će biti korišćen imperijalni ili metrički sistem jedinica.  

 

*************************************************************************** 

Postoji još jedna veoma korisna prečica za prebacivanje sa imperijalnog na metrički 

merni sistem upotrebom tastera Q, kada je aktivna radna površina PCB Editor. 

 

Još jedna korisna opcija je podešavanje mreže, koja olakšava poravnavanje komponenti (izgled 

mreže i razmak između linija u okviru nje nema nikakav uticaj na svojstva same pločice). Ova 

opcija se podešava iz menija Board Options -> Grids -> Menu -> Properties, čime se otvara 

dijalog za podešavanje mreže. Tipično podešavanje podrazumeva recimo, da u polja Step X i Step 

Y bude upisana vrednost od 10mil, a u polju Multiplier se izabere 10x Grid Step (Slika 52). 

Značenje ovih podešavanja je da se futprintovi komponenti mogu pomerati duž X i Y ose sa 

korakom od 10mil i da će na ekranu PCB Editora biti prikazane dve mreže, jedna sa tanjim sivim 

linijama razmaknutim 10mil (step), a druga sa debljim linijama razmaknutim 

10x10=100mil (multiplier).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 52.  Podešavanje parametara vidljive mreže u PCB Editoru 

 
Nakon ovoga, pristupamo raspoređivanju komponenti klikom na svaku od njih pojedinačno i 

njihovim prevlačenjem na željenu poziciju. Prlikom raspoređivanja, moguće je rotirati 

komponente pritiskom na Space dok je komponenta “u vazduhu”, na sličan način kao što je rađeno 

pri raspoređivanju komponenti u Schematic Editoru. Pri tome, kao što je već napomenuto, 
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potrebno je komponente rasporediti na takav način da se provodne veze što manje međusobno 

ukrštaju, a opet, da budu približnog rasporeda kao na šemi. Primer rasporeda futprintova 

komponenti prikazan je na Slici 53. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 53.  Primer raspoređvanja futprintova po radnoj površini PCB Editora 

 
 

2.2.4. Načini rutiranja 
 

 
Pošto je definisan raspored komponenti, odnosno njihovih futprintova, pristupa se izvlačenju 

provodnih veza, odnosno rutiranju. Rutiranje se može vršiti na dva načina: 
 

“Ručno”, pri čemu korisnik sam definiše geometriju provodnih veza korišćenjem 

odgovarajućih alata za rutiranje.  
Korišćenjem alata za automatsko rutiranje (AutoRouter), pri čemu je proces rutiranja 

prepušten programu. Ova opcija automatskog rutiranja data je čisto informativno, i nju ne treba koristiti prilikom 

projektrovanja štampane ploče, pogotovo kada su u pitanju složeniji dizajni. 
 
Na prvi pogled, opcija gde se korisnik prepušta veštini rutiranja kojom raspolaže sam softver deluje 

primamljivo, budući da iziskuje minimalan dodatni napor koji se svodi na uključivanje opcije za 

automatsko rutiranje. Međutim, još uvek važi nepisano pravilo da dobro uvežban inženjer 

neuporedivo bolje i efikasnije (nažalost ne i brže) obavlja ovaj zadatak, u poređenju sa 

najnaprednijim postojećim algoritmom za automatizovano rutiranje. Stoga, svaki iole složeniji 

dizajn se rutira ručno. U ovom slučaju, budući da je uređaj prilično jednostavan, AutoRouter će 

biti u stanju da izađe na kraj sa zadatkom. 
 
Pre samog rutiranja, potrebno je definisati pravila po kojima će se rutiranje obaviti. Ova pravila 

odnose se na parametre kao što su željena širina provodnih linija, broj provodnih slojeva ploče, 

minimalno rastojanje između provodnih linija, minimalno rastojanje između provodnih linija i 

lemnih mesta, minimalno rastojanje koje se odnosi na poligone i sl. Dijalog za njihovo zadavanje 

se otvara pomoću opcije Design -> Rules. Sa desne strane dijaloga, pojaviće se hijerarhijski 
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organizovana lista koja sadrži mnoštvo pravila koja je moguće definisati, od kojih će ovde biti 

objašnjena samo ona najvažnija koja su od interesa za realizaciju načeg projektong zadatka. 

 
 

2.2.5. Definisanje osnovnih pravila rutiranja 
 
Na Slici 54 je prikazan izgled prozora u kome se definišu pravila, otvoren iz padajućeg menija       
Design->Rules. 
 

 
Slika 54. Pravila vezana za rutiranje 

2.2.5.1. Definisanje slojeva koji se koriste pri rutiranju 
 

 
U uvodu je bilo reči o potrebi da štampana ploča bude projektovana tako da komponente budu 

međusobno povezane korišćenjem što je moguće manjeg broja provodnih slojeva, budući da veći 

broj slojeva povećava tehnološku složenost izrade, a samim tim i krajnju cenu ploče. U našem 

slučaju, pošto se radi o relativno jednostavnom uređaju, videćemo da je moguće realizovati ploču 

u najjednostavnijoj (jednoslojnoj) tehnologiji. Budući da su sve korišćene komponente “through-

hole” tipa, u ovom slučaju se logično nameće strategija projektovanja ploče po kojoj se same 

komponente nalaze sa gornje strane ploče, a lemne površine i signalne veze sa donje strane. Stoga 

je potreno dati programu do znanja da će pri rutiranju biti korišćen samo donji sloj ploče. Ovo 

pravilo se zadaje u okviru dijaloga PCB Rules and Constraint Editor, opcija Design Rules -> 

Routing Layers - > Routing Layers (Slika55). 
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Slika 55.  Podešavanje ograničenja vezano za slojeve rutiranja 

Pod opcijom Constraints definiše se koje slojeve je dozvoljeno koristiti pri rutiranju, u ovakvom 

slučaju potrebno je dozvoliti korišćenje donjeg sloja (Bottom Layer) i zabraniti korišćenje gornjeg 

sloja (Top Layer), kao što je prikazano na Slici 55. Nakon odabira odgovarajućih opcija, potrebno 

je pritisnuti taster Apply da bi izbor bio potvrđen.  
 
 
2.2.5.2. Definisanje širine provodnih veza 
 
 
Širina provodnih veza definiše se pomoću opcije Design Rules -> Width -> Width. U delu 

prozora Constraints, definiše se minimalna, preferirana i maksimalna širina provodnih linija 

(Slika 56). Ova širina se bira na osnovu tehnoloških parametara procesa izrade ploče. Generalno 

pravilo je da je poželjno da linije budu što šire, jer se tako smanjuje njihova otpornost, 

� = � ∙
�

�
	[Ω] 

gde je � specifična provodnost bakra, l dužina provodnika, a S površina poprečnog preseka. 

 

Veća debljina vodova omogućava i proticanje većih struja i smanjuje mogućnost da neka od veza 

bude u prekidu usled manjih defekata nastalih u procesu izrade, kao i rizik pucanja voda od 

strujnog preopterećenja. Sa druge strane, deblje linije je teže provlačiti između komponenti, čime 

se povećava površina ploče, a ponekad rutiranje postaje i nemoguće u zadatom broju slojeva, tako 
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da je potrebno preći na višeslojnu tehnologiju. Stoga, širina linija predstavlja stvar inženjerskog 

kompromisa, a u ovom konkretnom slučaju vrednosti širina koje u potpunosti zadovoljavaju 

potrebe projektog zadatka su one koje su prikazane na Slici 56 (min = 20mil, pref. = 30mil, max 

= 50mil). Autoruter će uvek pokušati da izvrši rutiranje sa koristeći preferiranu širinu. Ukoliko to 

na pojedinim mestima nije moguće, smanjiće širinu i to najviše do minimalne zadate vrednosti. 

Takođe, ako je na nekim mestima potrebno da linije budu šire (npr. one koje idu ka energetskim 

komponentama), tada je moguće “ručno” promeniti širinu linija, sve do maksimalne definisane 

vrednosti. Ukoliko se debljina voda ru;no pomeri na vrednost koja je veća od zadate maksimalne 

vrednosti, tada će taj vod da postane označen zelenim iksevima jer premašuje zadate opsege.  
 

 
Slika 56.  Definisanje širine provodnih veza 

 
2.2.5.3. Definisanje minimalnog rastojanja između objekata 

 

 
Minimalno rastojanje između objekata (provodnih linija ili padova komponenti) koji pripadaju 

različitim netovima definiše se pomoću opcije Design Rules -> Electrical -> Clearance -> 

Clearance. Ovu vrednost ćemo podesiti na 15mil (Slika 57). 
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Slika 57.  Definisanje minimalnog razmaka između objekata koji pripadaju različitim netovima 

 

 

2.2.5.4. Dodavanje novih pravila unutar postojećeg polja Clearance 
 

Takođe, u okviru Electrical -> Clearance dodefinisaćemo još jedno novo pravilo koje će se odnosti 

na poštovanje minimalnog razmaka koji će se nalaziti unutar kreiranih poligona. Da bismo 

definisali novo pravilo u okviru Clearance polja, potrebno je da kliknemo desnim tasterom miša 

na Clearance,  i dodamo opciju New Rule, kao što je prikazano na Slici 58. Pravilo ćemo nazvati 

npr. Poligon, i ovaj naziv ćemo upisati u opciju “Name” – Slika 59. Takođe, na Slici 59 možemo 

videti da je u okviru polja “Where the first object matches” odabrana stavka Custom Query, i u 

polje sa kursorom (polje za tekstualni unos opisa pravila unosimo sledeći tekst:  InPolygon). Ovo 

će se odnositi na Clearance pravilo unutar postavljenih poligona. Sada je još potrebno potaviti 

minimal clearance na željenu vrednost (u našem slučaju stavljamo 15 mil-a) (sva podešavanja se 

vide na Slici 59). 
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Slika 58.  Definisanje novog pravila unutar polja Clearance 

 
Slika 59. Dodeljivanje parametara i naziva novog pravila 
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2.2.5.5. Definisanje standardnih dimenzija za viju 
 
 

Unutar polja Routing-Routing Via Style, nalazi se opcija Routing Via, koja nam omogućava da 

definišemo pravilo koje će postaviti prečnik i rupu na viji koja nam omogućava spajanje različitih 

slojeva na štampanoj ploči. Podešavanja vezana za viju su prikazana na Slici 60. 

 

 
Slika 60. Podešavanja za prečnik vije 

 

2.2.6. Dodavanje klasa Net-Class i dodeljivanje debljine voda prilikom rutiranja 
 
Kako bismo omogućili rutiranje različitim debljinama vodova za različite klase netova (npr. Netovi 

koji pripadaju napajnaju, i trpe veće struje, pogodno je da budu deblji od signalinh vodova koji 

npr. mogu da služe samo za komunikacione protokole, rx, tx pinove itd…) moguće je automatski 

predefinisati ova pravila po klasama. Odabirom iz padajućeg menija na opciju Design->Classes, 

možemo zadati klase netovima. Potrebno je desnim tasterom miša kliknuti na Net Classes, i zatim 

dodati stvku, sa Add Class (Slika 61). Ponovnim odabirom desnog tastera miša, ali sada na New 

Class, otvoriće se opcija za dodavanje imena novoj klasi(Slika 62). Ovde ćemo uneti naziv: 

Power Class, što znači da će ovoj klasi biti dodeljeni Netovi napajanja, uključujući Vcc i 

referentni signal mase (signal mase se obično u ovakvim slučajevima ne rutira, već se masa 

okružuje poligonima, ali ćemo ipak masu svrstati u klasu Power Class). Ponavljanjem postupka 

dodaćemo i klasu Signal Class. Sada je potrebno u klasu Power Class uvrstiti odgovarajuće 

netove.  
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Slika 61. Dodavanje nove klase 

  

 
Slika 62.  Dodeljivanje naziva klasi 
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Slika 63. Dodeljivanje neova klasi 

Ovaj postupak dodeljivanja netova se ovdija najpre zadržavanjem tastera CTRL i klikom na sve 

netove koji će pripadati datoj klasi, a zatim klikom na znak >, kao što je prikazano na Slici 63. 

Nakon ovoga, klasa bi trebalo da poprimi nove članove, koje je korisnik selektovao i premestio u 

nju. Primer Klase Signal Class sa dodeljenim članovima je prikazan na Slici 64. 
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Slika 64. Klasa Dignal Class sa dodeljenim Netovima 

Nakon definisanja klasa, potrebno je vratiti se u prozor sa pravilima rutiranja, i u opciji Routing-

>Width->Width podeliti debljine vodova po klasama, kao što je prikazano na Slici 65. U polju 

Where to object matches odaberemo Net Class, pa najpre za klasu Power Class definišemo nove 

min, preferred i max vrednosti debljine vodova, a potom isto učinimo i za klasu Signal Class. 
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Slika 65.  Uputstvo za podešavanje debljine vodova po definisanim klasama koje određuju netovi 

 Nakon unešenih izmena potvrđujemo sa OK, čime se zatvara prozor sa pravilima. 

 
 

2.2.7. Korišćenje alata za automatsko rutiranje (izbrgavati ovu opciju kod složenog 
dizajna) 

 
 
Kada su komponente raspoređene i pravila za rutiranje definisana, sve je spremno za proces 

automatskog rutiranja koji se pokreće opcijom Auto Route -> All -> Route All. Nakon ovoga, 

ako je prethodno sve bilo podešeno kako treba, AutoRouter će pokušati da odradi rutiranje, 

poštujući usput sva definisana pravila. Ukoliko je to moguće, rutiranje će biti uspešno izvršeno 

nakon vrtemena koje zavisi od brzine računara i složenosti dizajna. Međutim ukoliko AutoRouter 

iz bilo kog razloga nije u mogućnosti da izvrši zadatak, iskočiće poruka koja sadrži detalje o 

problemu na koji je naišao. U tom slučaju, preporučuje se brisanje linija koje su u međuvremenu 

postavljene (opcija Tools -> Un-Route -> All), nakon čega je potrebno uneti izmene koje će 

omogućiti da rutiranje sledeći put uspe (npr. promeniti raspored komponenti ili neka od pravila 

rutiranja).  
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Konačni raspored provodnih veza nakon automatskog rutiranja prikazan je na Slici 661.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 66.  Izgled provodnih veza nakon automatskog rutiranja i iscrtavanja granične linije 

 
 

2.2.8. Brisanje linija vodova koje su u međuvremenu postavljene (UuRoute opcija) 
 
Bilo da se radi o automatskom ili ručnom rutiranju, ukoliko se iz nekog razloga želi ukloniti sve 

što je prethodno izrutirano, to se u svakom trenutku može učiniti odabirom na padajući meni     

Tools -> Un-Route -> All. 

 

2.2.9. Konflikt usled neispoštovanih definisanih pravila 
 
Ukoliko se neka od prethodno definisanih pravila nađu u konfliktu, npr. dve komponente se fizički 

preklapaju (ovo je samo jedan primer, na Slici 66, ali ovakve konflikte mogu izazvati razna 

ukrštanja parvila, kao što su ručne promene debljine vodova ispod minimalne ili maksimalne 

definisane vrednosti, itd), to će se odraziti tako što će komponente koje izazivaju konflikt postati 

uokvirene zelenom bojom. 

                                                   
1 Pošto je pravilima definisano da se pri rutiranju koristi smao donji sloj, sve provodne linije su plave boje. 
 
Linije koje pripadaju gornjem sloju se prikazuju crvenom bojom. Više reči o tome će biti u vežbi 2. 
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Slika 67. Primer konflikta zbog fizičkog ukrštanja prostora nad komponentama J1 I P1 

 
Najbolje rešenje je da se ovaj konflikt reši pomeranjem jedne komponente iz prostora druge, ali 

ukoliko korisnik ipak želi da nastavi sa svojom idejom, i ukloni upozorenje, može to učiniti klikom 

na padajući meni Tools->Reset Error Markers. Nakon ovoga, zeleni okvir nad konfliktima će 

nestati iako uzrok nije uklonjen. Ovo se naravno ne primenjuje kada se dve komponente fizički 

nađu u istom prostoru, već kada zaista ima razloga da se upozorenja ignorišu. Ovaj primer je čisto 

ilustrativnog tipa. Komponente u nedozvoljenom položaju nakon otklanjanja upozorenja (ali ne i 

rešavanja uzroka konflikta prikazane su na Slici 68. Možemo videti da je upozorenje nestalo iako 

je problem i dalje prisutan.) 
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Slika 68. Ignorisanje problema preklapanja komponenti (samo ilustrativnog primera, NE KORSITI u 
praksi za ovakve vrste konflikata) 

2.2.10. Automatsko poravnavanje prilikom pomeranja komponenti u PCB editoru 
 
Slično kao i u Shematic Editoru, i na PCB-u je moguće poravnavanje komponenti, selektovanjem 

više komponenti (tom prilikom se zadržava taster SHIFT), i nakon selektovanja (otpušta se SHIFT 

kada se ovo selektovanje završi) korišćenjem prečica CTRL+SHIFT+L (za poravnanje prema 

selektovanoj komponenti koja se nalazi na željenoj poziciji sa leve strane u odnosu na ostale 

selektovane komponente), CTRL+SHIFT+R (za poravnanje prema selektovanoj komponenti koja 

se nalazi na željenoj poziciji sa desne strane u odnosu na ostale selektovane komponente), 

CTRL+SHIFT+T (za poravnanje prema selektovanoj komponenti koja se nalazi na željenoj 

poziciji sa gornje strane u odnosu na ostale selektovane komponente), CTRL+SHIFT+B (za 

poravnanje prema selektovanoj komponenti koja se nalazi na željenoj poziciji sa donje strane ploče 

u odnosu na ostale selektovane komponente). Alternativna metoda za poravnanjeje da se nakon 

selekcije više komponenti klikne desni taster miša i odabere Allign a zatim jedna od ponuđenih 

opcija: Allign Left, Allign Right, Allign Top, ALlign Bottom. Na Slici 69 prikazano je poravnavanje 

dva otpornika RB7 i RB6 prema poziciji otpornika RB7 koji se nalazi “više na dole” u odnosu na 

otpornik RB6, te je stoga opcija Allign Bottom upravo poravnanje prema RB7. 
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Slika 69.  Automatsko poravnavanje komponenti prilikom pomeranja u PCB editoru 

 

2.2.10. Definisanje fizičkih dimenzija ploče 
 

 
Nakon što je rutiranje automatskim alatom uspešno obavljeno, potrebno je definisati fizičke 

dimenzije ploče. To se radi iscrtavanjem granične linije u sloju ploče koji se naziva Keep-Out 

Layer. Opcija Place -> Keepout -> Track omogućava crtanje granične linije koja će biti 

prikazana u rozoj boji (Slika 66 desno). Potrebno je još obratiti pažnju na detalj da gornji deo 

komponente konektora za serijsku vezu izlazi izvan granica ploče, pošto je to deo konektora na 

koji se povezuje kabel.  
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Ovim korakom je proces projektovanja štampane ploče uspešno zaokružen. Ipak, ovde će biti 

prikazan još jedan koristan detalj projektovanja. Ako za izradu ploče nameravamo da koristimo 

CNC glodalo kod kojeg alat mehanički skida višak bakra sa površine ploče, u ovom slučaju će alat 

imati relativno mnogo posla, pošto je veći deo površine ploče “prazan“. Da bismo smanjili habanje 

mašine i višestruko ubrzali postupak izrade, popunićemo prazne površine donjeg sloja ploče 

bakarnim poligonom. U ovu svrhu se koristi opcija Place -> Polygon Pour, čime se otvara dijalog 

za definisanje parametara poligona koji će biti dodat. Izbor opcija je prikazan na Slici 70 levo, 

čime je definisano da poligon bude od punog bakra (Solid), da pripada donjem sloju (Properties 

-> Layer -> Bottom Layer) i da ne pripada nijednom netu (Net Options -> Connect to Net -> 

No Net). Nakon pritiska na taster OK, postavljanjem kursora na odgovarajuće pozicije klikom na 

levi taster miša se definišu temena poligona. Nakon što smo na ovaj način definisali četvorougaoni 

oblik, poligon se iscrtava i njegov izgled je prikazan na Slici 70 desno. Ovim je rad mašine za 

izradu ploča znatno skraćen i olakšan, jer je potrebno skinuti višak bakra samo u neposrednoj 

blizini provodnih linija i padova komponenti.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 70.  Konačni izgled štampane ploče nakon dodavanja bakarnog poligona 
 
 
Pravilo  Clearence-a koje smo definisali u odeljku 2.2.5.4. a odnosi se na polygon, možemo videti 

na Slici 71. Ovo pravilo omogućuje da se prilikom kreiranja poligona održavaju minimalna 

ograničenja prilaska polja poligona vodovima i padovima komponenti. 
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Čest je slučaj i da se poligon pridružuje nekom od netova za napajanje, obično je u pitanju masa 

(GND). O ovome će biti više reči u odeljku koji se odnosi na savete oko rutiranja i 

elektromagnetskoj kompatibilnosti (EMC). 

Slika 71.  Minimalna distanca polja poligona od padova komponenti i vodova 
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2.3. VEŽBA 2 a) – Električna šema Bežičnog mikrofona u Shematic 
Editoru 

 

 
U prethodnoj vežbi bio je ilustrovan postupak projektovanja štampane ploče jednostavnog 

elektronskog uređaja, pri čemu su pokazane osnovne funkcije i alati za rad u Schematic Editoru, 

Schematic Library Editoru i PCB Editoru. Vežba br. 2 prikazuje dodatne funkcionalnosti softvera, 

kao i postupak definisanja korisničkih futprintova u PCB Library Editoru, na primeru 

projektovanja ploče nešto složenijeg uređaja. U pitanju je uređaj koji pomoću mikrofona 

konvertuje zvučni signal u njegov električni ekvivalent, pojačava ga i vrši njegovu frekventnu 

modulaciju (FM), u svrhu bežičnog prenosa signala do udaljenog prijemnika. Šema ovog uređaja 

prikazana je na Slici 72.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 72.  Električna šema uređaja 

Kao i u prethodnoj vežbi, prvi korak podrazumeva definisanje novog projekta (u novom folderu 

na hard disku) i u okviru njega .SchDoc dokumenta u kojem će biti nacrtana šema uređaja. Izgled 

Shematic Editora sa unetim osnovnim parametrima projekta prikazan je na Slici 73. 
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Slika 73.  Projekat FM Predajnik, sa unetim parametrima u Shematic Editoru 

 
 

2.3.1. Podaci o komponentama potrebnim za crtanje šeme FM predajnika 
 

 
Sledeći korak podrazumeva crtanje šeme, kao što je prikazano na slici 2.1. Većina upotrebljenih 

komponenti (mikrofon, otpornici, kondenzatori, kalem, antena, baterija, NPN tranzistor) nalaze se 

na već poznatom mestu, u okviru biblioteke Miscellaneous Devices.IntLib. U tabeli 2.1 prikazane 

su oznake komponenti korišćenih u ovom projektu i njihovi atributi. Oznake futprintova koje se 

razlikuju od podrazumevanih su obeležene žutom bojom i o njima će biti reči nešto kasnije. 
 
Komponenta Simbol 

 
Biblioteka 
simbola   

Oznaka 
(Designat

or)   

Vrednost
(PartTyp

e)   Futprint   Biblioteka 

  

  
  

 
 

  
 

  
 

   
 

  
futprinta 

  
              
   

Miscellane
ous 

  
R1, R2, 

R3, 
                   

Miscellane
ous 

  

Otpornik 1, 2, 3, 4 Res2 
     

4K7 
  AXIAL-

0.4 
    

 Devices.Int
Lib 

  
R4 

      Devices.Int
Lib 

  
                          
   

Miscellane
ous 

                      
Miscellane

ous 

  

Otpornik 5 Res2 
   

R5 
  

150K 
  AXIAL-

0.4 
    

 Devices.Int
Lib 

        Devices.Int
Lib 

  
                           

Otpornik 6 Res2 
 

Miscellane
ous   

R6 
 

220 
  AXIAL-

0.4 
  

Miscellane
ous   
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Devices.Int

Lib                       
Devices.Int

Lib   

Otpornik 7 Res2 
 

Miscellane
ous   

R7 
  

3K9 
  AXIAL-

0.4 
  

Miscellane
ous   

 Devices.Int
Lib 

        Devices.Int
Lib 

  
                           
   

Miscellane
ous 

                      
Miscellane

ous 
  

Otpornik 8 Res2 
   

R8 
 

100 
  AXIAL-

0.4 
    

 Devices.Int
Lib 

       Devices.Int
Lib 

  
                           
   

Miscellane
ous 

                         

Elektrolitski 
kondenzator 1 Cap Pol1 

   
C1 

  
22u 

    RB.1
/.2 

     
Otisak.lib 

  
 Devices.Int

Lib 
               

                            
   

Miscellane
ous 

                      
Miscellane

ous 
  

Kondenzator 2, 3 Cap 
   

C2, C3 
  

10n 
   RAD-

0.2 
      

 Devices.Int
Lib 

           Devices.Int
Lib 

  
                           
   

Miscellane
ous 

                         

Kondenzator 4, 5, 6 Cap 
   C4, C5, 

C6 
  

1n 
  RAD-

0.4C 
   

Otisak.lib 
  

 Devices.Int
Lib 

           
                            
   

Miscellane
ous 

                         

Elektrolitski 
kondenzator 7 Cap Pol1 

   
C7 

  
4u7 

    RB.1
/.2 

     
Otisak.lib 

  
 Devices.Int

Lib 
             

                            
   

Miscellane
ous 

                      
Miscellane

ous 
  

Kondenzator 8 Cap 
   

C8 
  

33p 
   RAD-

0.2 
      

 Devices.Int
Lib 

          Devices.Int
Lib 

  
                           
   

Miscellane
ous 

                         

Kondenzator 9 Cap Var 
   

C9 
  

5-60p 
     VA

RC 
      

Otisak.lib 
  

 Devices.Int
Lib 

              
                            

Baterija Battery 
 

Miscellane
ous   

BT1 
  

9V 
     BA

T-2 
  

Miscellane
ous   

 Devices.Int
Lib 

           Devices.Int
Lib 

  
                           
   

Miscellane
ous 

                         

Mikrofon Mic2 
   

MK1 
  

Mic2 
      

EMI
C 

       
Otisak.lib 

  
 Devices.Int

Lib 
                

                            
   

Miscellane
ous 

                      
Miscellane

ous 
  

NPN tranzistor NPN 
   

T1 
  

BC108 
     TO-

18 
        

 Devices.Int
Lib 

            Devices.Int
Lib 

  
                           
   

Miscellane
ous 

                         

Prigušnica Inductor 
   

L1 
  

L400 
       L4

00 
        

Otisak.lib 
  

 Devices.Int
Lib 

                
                            
   

Miscellane
ous 

                      
Miscellane

ous 

  
Antena Antenna    A1   Antenna            
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 Devices.Int
Lib 

           
PIN

1   Devices.Int
Lib 

  
                           

Operacioni 
pojačavač 

LM358A
N 

 
ST 

Operational   
IC1 

  
LM358 

       DIP
8 

  
ST 

Operationa
l   

 Amplifier.I
ntLib 

             Amplifier.I
ntLib 

  
                            
 

Tabela 2.1. Korišćene komponente i njihovi atributi 
 
 

2.3.2. Pretraživanje integrisanih biblioteka komponenti 
 

 
U ovom slučaju, jedina komponenta koja se ne nalazi u biblioteci Miscellaneous Devices.IntLib 

je operacioni pojačavač (skraćeno OP) sa oznakom LM358. Ako želimo da dođemo do detaljnijih 

informacija o ovoj komponenti, korišćenjem web pretraživača pronađemo i otvorimo 

odgovarajuću dokumentaciju – datasheet proizvođača. Kada je u pitanju dizajn štampane ploče, 

relevantna je informacija da se radi o integrisanom kolu u DIP-8 kućištu u kojem su smeštena dva 

operaciona pojačavača. Raspored i funkcije pinova prikazani su na Slici 74.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 74.  Raspored i funkcije pinova integrisanog kola LM358 

    Link: https://www.ti.com/lit/ds/symlink/lm158-n.pdf  
 
U prvoj vežbi prikazan je postupak kreiranja nove komponente u okviru korisničke biblioteke 

komponenti. Međutim, ukoliko komponenta već postoji u nekoj od instaliranih biblioteka, nije 

neophodno kreirati je iz početka, nego je dovoljno pronaći u kojoj biblioteci se nalazi i odatle je 

postaviti na radnu površinu Schematic Editora. Slika 76 prikazuje postupak pronalaženja 

komponente korišćenjem alata za pretraživanje biblioteka (opcija Search u okviru panela 

Libraries (Slika 75)): 
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Slika 75.  Opcija Search u panelu Libraries 

 
1. Kriterijum pretraživanja je definisan kao “Name contains LM358“, čime se od 

pretraživača zahteva da pronađe sve komponente u čijem se nazivu sadrži string  
“LM358“. U polju Scope je još potrebno izabrati opciju Libraries on path i definisati 

putanju ka folderu koji sadrži biblioteke komponenti u okviru polja Path. Pretraga se 

pokreće klikom na opciju Search.  
2. Nakon pretrage, panel Libraries sadrži spisak komponenti koje zadovoljavaju kriterijum 

pretrage. Na spisku pronađemo komponentu sa odgovarajućim futprintom, npr. 

LM358AN u okviru biblioteke ST Operational Amplifier.IntLib. Nakon selekcije 

komponente, potrebno je kliknuti na Place LM358AN, kako bi komponenta bila 

postavljena na radnu površinu Schematic Editora. 

3. Ukoliko biblioteka u kojoj se komponenta nalazi nije već bila prethodno instalirana, 

pojaviće se dijalog u okviru kojeg je potrebno dozvoliti instalaciju biblioteke klikom na 

opciju Yes.  
4. Pre postavljanja operacionih pojačavača u Schematic Editor, pritiskom na taster Tab na 

tastaturi otvaramo dijalog za zadavanje atributa. U polju Designator upišemo IC1, a u 

polju Comment upišemo LM348. Nakon toga klikom na OK postavljamo simbole OP na 

šemu.  
5. Pošto se kod ove komponente dva operaciona pojačavača nalaze u istom kućištu, 

komponenta se u logičkom smislu sastoji iz dva dela (Part 1 i Part 2). Svakom od njih će 

na šemi biti dodeljen po jedan simbol sa jedinstvenom oznakom, tako da prvi OP (Part 1) 

dobija oznaku IC1A, a drugi (Part 2) dobija oznaku IC1B.  
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Slika 76.  Postupak pretraživanja biblioteka 

 
Napomena: iako su pinovi za napajanje i masu (4 i 8) prikazani na oba simbola OP, dovoljno je 

povezati ih na odgovarajuće portove za napajanje samo na jednom mestu, pošto ova dva simbola 

pripadaju istoj fizičkoj komponenti. Na primer, na Slici 72 pinovi 4 i 8 simbola IC1A su spojeni 

na izvor napajanja i masu, a pinovi 4 i 8 simbola IC1B nisu2. 
 
 
 
 

2.3.3. Kreiranje futprintova komponenti u PCB Library Editoru 
 

 
Nakon što su komponente postavljene i međusobno povezane, potrebno im je dodeliti 

odgovarajuće futprintove, kao što je to bio slučaj i u prethodnoj vežbi. Pojedine komponente 

(otpornici, konektor za bateriju I operacioni pojačavač LM358) već imaju adekvatne futprintove 

koje nije potrebno menjati. Kod preostalih komponenti biće potrebno izvršiti određene intervencije 

(to su komponente čiji futprintovi su označeni žutom bojom u tabeli 2.1). Ovde će biti ilustrovan 

                                                   
2 Ako želimo da isključimo prikaz pinova 4 i 8 u okviru simbola IC1B, otvorimo dijalog za zadavanje njegovih 
atributa dvostrukim klikom miša, izaberemo opciju Edit Pins i isključimo opciju Show za pinove 4 i 8. 
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postupak kreiranja biblioteke korisničkih futprintova, na primerima pojedinih komponenti 

korišćenih u ovom projektu. 
 
Najpre je potrebno u projekat dodati novu (praznu) biblioteku futprintova odabirom opcije iz 

padajućeg menija File -> New -> Library -> PCB Library. U hijerarhiji projektnih datoteka će 

se pojaviti nova biblioteka pod nazivom PcbLib1.PcbLib. Pre početka rada sa njom, potrebno je 

snimiti ovu biblioteku (desni taster miša u polju PcbLib1.PcbLib i odabir na Save) pod novim 

imenom Otisak.PcbLib. 

 
 

2.3.4. Primer kreiranja futprinta elektrolitskih kondenzatora C1 i C7 (22uF i 4u7F) 
 

 
Na Slici 77 je prikazan izgled elektrolitskog kondenzatora. U slučaju komponente koju koristimo 

u ovoj vežbi, udaljenost između priključaka je 100 mil dok je prečnik osnove kućišta 200 mil. 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Slika 77.  Fizički izgled elektrolitskog kondenzatora 0.47uF/50V 

 
Kreiranje novog futrprinta započinje klikom na panel PCB Library, u okviru kojeg se u polju 

Components nalazi lista futprintova koji se trenutno nalaze u biblioteci (Slika 78). 

 

 U početku u biblioteci se nalazi samo jedan futprint generički nazvan PCBCOMPONENT_1. 

Dvostrukim klikom levog tastera miša otvara se dijalog u kojem je moguće promeniti ovaj naziv, 

u ovom slučaju novi naziv će biti RB.1/.211. Nakon zadavanja naziva, u glavnom delu ekrana 

postaje vidljiva radna površina PCB Library Editora. Krug sa krstićem u sredini označava 

koordinatni početak. 
 
Od ključne je važnosti da izgled futprinta i sve dimenzije tačno odgovaraju fizičkom izgledu i 

dimenzijama komponente, pošto bilo kakva greška u tom smislu može dovesti do toga da nakon 

izrade štampane ploče montaža komponente bude otežana, ili potpuno onemogućena. Stoga je 

preporučljivo pre početka rada podesiti parametre okruženja, tako da crtanje samog futprinta bude 

što lakše i preciznije: 
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Klikom na desni taster miša u okviru radne površine otvara se kontekstni meni u kojem se izabere 

opcija Library Options -> Grids -> Menu -> Properties, koja otvara dijalog za zadavanje 

koordinatne mreže. Podešavanje ćemo izvršiti na isti način kao što je to 
 
 
11 Smisao ove oznake proizilazi iz mehaničkih svojstava kondenzatora: RB označava da se radi o 
radijalnom futprintu, 0.1 je razmak između lemnih mesta (padova), a 0.2 označava spoljašnji 
prečnik. 

Slika 78.  Prozor sa kreiranom novom PCB bibliotekom 
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urađeno u PCB Editoru u prethodnoj vežbi (slika 1.21, Step X = Step Y = 10mil, Multiplier = 10x 

Grid Step). 

Uvek se preporučuje da pozicije padova budu takve da je koordinatni početak u sredini 

komponente. 

Koordinatni početak označen je simbolom koji je uokviren na Slici 79. 

 

Slika 79. Krst koji označava koordinatni početak 

Ovo olakšava kasnije pozicioniranje futprinta u PCB Editoru. Pri crtanju futprinta, trenutna 

pozicija kursora se ispisuje u donjem levom uglu ekrana, što dodatno olakšava posmatranje 

futprinta u realnim fizičkim dimenzijama. 

 

2.3.4.1. Promena koordinatnog početka u PCB biblioteci 
 

Koordinatni početak je izmenjiv, odnosno korisnik može da ga postavi bilo gde. Postupak promene 

je određen na jedan od tri moguća načina:  

 postavljanjem u centar nacrtane komponente,  

 postavljanjem na Pin 1 nacrtane komponente, 

 postavljanjem na željenu lokaciju (trenutne X i Y koordinate na radnoj površini). 

Odabirom opcije Edit->Set Reference-> (Pin1, Center ili Location) iz padajućeg menija definiše 

se novi koordinatni početak (Slika 80).  
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Slika 80.  Pomeranje koordinatnog početka 

 
U ovom slučaju, futprint će se sastojati od dva Pin-a (Pad-a), granične linije i krstića koji označava 

pravilnu orjentaciju komponente (odnosno pozitivni kraj, što je u ovom slučaju od značaja budući 

da se radi o elektrolitskom kondenzatoru). Padovi se postavljaju korišćenjem opcije Place -> Pad, 

ili klikom na ikonicu Place Pad u paleti sa alatima. Oznake padova moraju biti takve da 

odgovaraju oznakama pinova na oznaci komponente u Schematic Editoru. Prema tome, potrebno 

je vratiti se u Schematic Editor radi provere oznaka pinova. Dvostrukim klikom na elektrolitski 

kondenzator C1 na šemi, otvara se dijalog za zadavanje njegovih atributa, u okviru kojeg je 

potrebno uključiti opciju Graphical -> Show All Pins On Sheet (Even if Hidden). Na ovaj način 

oznake pinova koje su bile sakrivene postaju vidljive (Slika 81). Sada je jasno da pin koji odgovara 

pozitivnom kraju kondenzatora nosi oznaku 1, a drugi pin koji odgovara negativnom kraju nosi 

oznaku 2. Pošto su utvrđene oznake pinova i njihovo značenje, ponovo isključujemo prikaz naziva 

pinova u Schematic Editoru i vraćamo se u PCB Library Editor.  
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Slika 81.  Provera oznaka pinova komponente u okviru Schematic Editora 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 

Dakle, padovima na futprintu će biti dodeljene oznake 1 i 2, da bi se poklapale sa oznakama pinova 

u Schematic Edotoru. Da bi razmak između padova na futprintu bio odgovarajući (100 mil), 

postavljamo pad 1 na koordinate (-50, 0), a pad 2 na koordinate (50, 0). Pre postavljanja Pad-a na 

odgovarajuće mesto, moguće je klikom na TAB dodati designator “1” Padu i tada će svaki sledeći 

postavljeni Pad biti inkrementovan za vrednost 1. Ovo može biti korisno ukoliko se crta footprint 

za neki mikrokontroloer ili čip koji ima mnoštvo pinova, jer će po automatizmu pinovi da se 

inkrementuju.  
 
Dvostrukim klikom na postavljeni pad, otvara se dijalog za zadavanje njegovih atributa 
(Slika 82): 
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Slika 82.  Atributi Pad-a 

 
Opcija Size and Shape određuje fizičke dimenzije (X-Size, Y-Size) i oblik same lemne površine, 

koji može biti okrugao, pravougaoni (sa ili bez zaobljenih uglova) ili osmougaoni.  
Opcija Hole Size određuje prečnik rupe, kada je u pitanju pad through-hole komponente. 

Standardne dimenzije koje odgovaraju većini ovakvih komponenti su 32 mil (približno 0.8mm) i 

40 mil (približno 1mm). 
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Opcija Layer određuje kojem sloju ploče pripada pad. Podrazumevana opcija je Multi-Layer, 

koja pretpostavlja postojanje i isti oblik lemnog mesta na svim slojevima na kojima je rutiranje 

dozvoljeno. Uz to, podrazumeva se da će na mestu pada biti izvršena metalizacija, odnosno 

električno spajanje između različitih slojeva. Objekti koji imaju Multi-Layer svojstvo su 

predstavljeni svetlo sivom bojom. Padovi SMD komponenti obično pripadaju samo onom sloju 

koji je sa iste strane pločice kao i sama komponenta (Top Layer ili Bottom Layer) i stoga su 

označeni bojom odgovarajućeg sloja (npr. pad koji pripada komponenti na Top Layer-u označen 

je crvenom bojom). 

 

Treba primetiti da su na Slici 82 sve jedinice u mil-ima. Da bi se jedinice prikazivale u mm, 

potrebno je kliknuti levim tasterom miša na prazan prostor radne površine (u ovom slučaju 

prethodno treba zatvoriti dijalog prozor sa atributima), i nakon toga pritisnuti taster “Q” na 

tastaturi. Kada ponovo otvorimo prozor sa atributima komponente, vidimo da će se merne jedinice 

prebaciti u mm, kao što je prikazano na Slici 81. 



84 
 

 
Slika 83.  Prebacivanje prikaza između “mil” i “mm” upotrebom prečice Q tastera na tastaturi 

 
Pošto su padovi postavljeni i pošto su im dodeljene odgovarajuće oznake, potrebno je još iscrtati 

graničnu liniju koja predstavlja projekciju tela komponente na površinu ploče. Ovo je estetski 

zahvat koji je važan da bi se stekao utisak o stvarnim dimenzijama komponente, što je naročito 

bitno pri razmeštaju futprintova komponenti na ploču, kako bi se izbegla eventualna preklapanja. 

U ovom slučaju, granična linija predstavlja krug prečnika 200 mil, sa centrom u koordinatnom 



85 
 

početku. Opcija kojom se ovakva linija postavlja na radnu površinu je Place -> Full circle. Pre 

crtanja, pritiskom na taster Tab na tastaturi, potrebno je u dijalogu za zadavanje parametara 

izabrati opciju Layer -> Top Overlay12. Objekti koji pripadaju ovom sloju su predstavljeni žutom 

bojom13, a najčešće su u pitanju slovne oznake i granične linije komponenti. Nakon izbora sloja, 

iscrtavamo krug (koji se zapravo tretira kao kružni luk sa ugaonim parametrom od 360 stepeni), 

postavljanjem centra u koordinatni početak i zadavanjem dimenzije poluprečnika na 100 mil. 
 
Poslednji korak u crtanju ovog futprinta je iscrtavanje oznake “+“ koja označava pozitivan kraj 

kondenzatora, pa ga je zato potrebno postaviti pored pina 1. Ovo se postiže postavljanjem jedne 

horizontalne i jedne vertikalne linije u Top Overlay sloju, pomoću opcije Place -> Line. Konačan 

izgled futprinta komponente je prikazan na Slici 84.  
 
 
 
 
 
12 Česta početnička greška je da se ostavi podrazumevana opcija (Top Layer), nakon čega će 
iscrtana linija pripadati gornjem sloju ploče i biti označena crvenom bojom.  

13 Proizvođači štampanih ploča najčešće nude tzv. silkscreen opciju, koja podrazumeva da nakon 
izrade ploče objekti koji pripadaju Top Overlay sloju budu odštampani belom bojom po površini 
ploče. Ova opcija nije neophodna pošto je estetske prirode i nema nikakav uticaj na funkcionalnost 
uređaja. 
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Slika 84.  Konačan izgled futprinta elektrolitskog kondenzatora RB.1/.2 

 

2.3.5. Futprint kondenzatora C4, C5 i C6 (0.001uF=1nF) 
 

 
Na Slici 85 levo je prikazan kondenzator vrednosti 1nF. Rastojanje između nožica komponente je 

400 mil. Dužina tela komponente je oko 700 mil, dok je širina komponente oko 300 mil. Iako u 

postojećim bibliotekama postoji futprint RAD-0.4 koji približno odgovara ovim dimenzijama, 

problem je što su njegova širina i dužina manje od fizičkih dimenzija komponente, pa je potrebno 

kreirati novi futprint odgovarajućih dimenzija. Iznad praznog prostora u listi futprintova u okviru 

panela PCB Library kliknemo desnim tasterom miša i izaberemo opciju New Blank Component. 

Time će u listu biti dodat nov prazan futprint, ponovo pod nazivom PCBCOMPONENT_1. 

Potrebno je promeniti naziv futprinta u RAD-0.4C, a zatim nacrtati futprint tako da odgovara 

fizičkim dimenzijama kondenzatora. Za razliku od elektrolitskih kondenzatora, ovakvi 

kondenzatori su simetrične komponente (nemaju polaritet), pa zato nema potrebe za dodavanjem 

oznaka koje bi označavale njihovu orjentaciju. Krajnji izgled futprinta je prikazan na 

Slici 85 desno. 



87 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 85.  Fizički izgled kondenzatora 1nF (levo) i futprint RAD-0.4C (desno) 

 

2.3.6. Futprint promenljivog kondenzatora C9 (5-60pF) 
 

 
Na Slici 86 je prikazan fizički izgled promenljivog kondenzatora, kao i njegov simbol. Može se 

videti da komponenta ima tri nožice, odnosno njen futprint ima tri pada. Međutim, šematski simbol 

iste komponente pokazuje da postoje dva pina. Pogled na komponentu sa donje strane (Slika 86 u 

sredini) otkriva da su dva od tri pada koji su postavljeni dijametralno suprotno kratko spojeni. To 

znači da na futprintu ova dva pada trebaju da nose istu oznaku 1 (dozvoljeno je da više padova ima 

istu oznaku), a treći pad će nositi oznaku 2. Ovim je rešen problem uparivanja pinova na šemi i 

padova na futprintu. 
 
Merenjem dimenzija komponente, vidi se da padovi leže na kružnici prečnika 300 mil, koja ujedno 

predstavlja i graničnu liniju futprinta i predstavljena je kružnicom u Top Overlay sloju. Izgled 

futprinta nazvanog VARC u biblioteci Otisak.PcbLib prikazan je na slici 87. 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 86.  Fizički izgled promenljivog kondenzatora 
 
 
 
 
 
 
 
 
 
 
 
 

 
Slika 87.  Futprint promenljivog kondenzatora VARC 
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2.3.7. Futprint mikrofona 
 

 
Mikrofon tipa electret je prikazan na Slici 88, levo. Dimenzije kućišta bitne za izradu futprinta su 

sledeće: udaljenost nožica je 100mil, prečnik tela mikrofona je 400mil. Oznake padova su 1 i 2 

(proveriti u Schematic Editoru). Izgled futprinta pod nazivom EMIC u biblioteci Otisak.PcbLib 

prikazan je na Slici 88, desno.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 88.  Fizički izgled mikrofona (levo) i futprint EMIC (desno) 

 

2.3.8. Futprint prigušnice (zavojnica, kalem) L400 
 

 
Na Slici 89 levo je fizički izgled prigušnice. Oznake padova su 1 i 2. Udaljenost nožica 

komponente je 300 mil dok je širina poprečnog preseka 100mil. Telo komponente je predstavljeno 

kosim linijama u Top Overlay sloju, koje asociraju na fizički izgled i namenu komponente. Izgled 

futprinta pod nazivom L400 u biblioteci Otisak.PcbLib prikazan je na Slici 89 desno.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
Slika 89.  Fizički izgled prigušnice (levo) i futprint L400 (desno) 
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2.3.9. Futprint kondenzatora C2, C3 i C8 (0.01uF=10nF i 33pF) 
 
 
Na Slici 90 je prikazan kondenzator vrednosti 10 nF. Udaljenost između pinova je 200 mil. 

Debljina kućišta ne prelazi 100mil. U biblioteci Miscellaneous Devices.IntLib postoji 

odgovarajući futprint za ovakvu komponentu pod nazivom RAD-0.2. 
 
 
 
 
 
 
 
 
 
 

Slika 90.  Fizički izgled kondenzatora 10nF 

 

2.3.10. Futprint tranzistora BC108 
 

 
Na osnovu datasheet-a npn tranzistora BC108 dobijene su osnovne informacije o fizičkim 

dimenzijama komponente, broju i značenju svakog pada futprinta (Slika 91). Proizvođač je naveo 

da je naziv kućišta komponente TO-18. 
 
 
 
 
 
 
 
 
 
 
 
 

 
Slika 91.  Fizički izgled tranzistora BC108 (levo), simbol tranzistora (u sredini) i futprint TO-18 (desno) 

 
Pošto opcija Search za tranzistor BC108 u okviru dostupnih biblioteka nije vratila nikakav rezultat 

(jer se radi o zastareloj komponenti), pri crtanju šeme je korišćen generički simbol NPN tranzistora 

iz biblioteke Miscellaneous Devices.IntLib. Zbog toga je potrebno proveriti da li se oznake pinova 

simbola NPN tranzistora poklapaju sa oznakama u datasheetu i na futprintu, uključivanjem opcije 

Show All Pins On Sheet. Nakon uključivanja ove opcije, nazivi pinova postaju vidljivi (Slika 92 

levo) i postaje evidentno da imamo problem sa oznakama: 
 

Elektroda Oznaka pina na šematskom simbolu Oznaka pada na futprintu 
Emiter (E) 3 1 
Baza (B) 2 2 

Kolektor (C) 1 3  
Tabela 2.2. Neusklađene oznake pinova simbola NPN i padova futprinta TO-18 
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40  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Slika 92.  Promena oznaka pinova simbola NP tranzistora 

 
Dakle, ono što je potrebno uraditi je zamena oznaka emitera i kolektora u okviru šematskog 

simbola NPN tranzistora. U okviru dijaloga za zadavanje atributa simbola tranzistora izaberemo 

opciju Edit Pins, čime se otvara dijalog prikazan na Slici 92, u sredini. Ovde je potrebno promeniti 

oznaku emitera na 1 i oznaku kolektora na 3. Nakon unošenja izmena i klika na OK, oznake pinova 

će biti promenjene, kao što je prikazano na Slici 92 desno, posle čega možemo ponovo isključiti 

opciju Show All Pins On Sheet, Slika 93. 

 

 
Slika 93.  Prikaz i otključavanje pinova odabirom properties opcije za komponentu na Shematic Editoru 
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2.3.11.  Dodela futprintova komponentama koje nemaju automatski dodeljen futprint 

 
Pošto su u okviru biblioteke Otisak.PcbLib definisani svi potrebni futprintovi koji se nisu već 

nalazili u standardnim bibliotekama, potrebno je sačuvati biblioteku na hard disku (opcija Save), 

nakon čega se u Schematic Editoru simbolima dodeljuju futprintovi, na isti način kao što je 

prikazano u vežbi br.1 (dijalog za dodelu atributa komponente, opcija Models -> Add -> 

Footprint. Kad su u pitanju komponente čiji futprintovi se nalaze u biblioteci Otisak.PcbLib, njih 

je moguće odabrati pomoću opcije Browse u okviru dijaloga PCB Model, ili eventualno ručnim 

unosom naziva futprinta. Opcija Pin Map u okviru istog dijaloga omogućava proveru da li oznake 

pinova šematskog simbola odgovaraju oznakama padova futprinta komponente. 
 
Pre prelaska u PCB Editor, potrebno je još jednom proveriti da li nazivi, oznake, vrednosti i 

futprintovi komponenti odgovaraju atributima koji su prikazani u tabeli 2.1. 
 
 
 

2.3.12. Rutiranje (ručno) štampane ploče u PCB Editoru 

 
Sledeći korak je dodavanje novog praznog PCB fajla u projekat, kao i u prethodnoj vežbi. U PCB 

fajl koji će biti snimljen pod nazivom Ploca.PcbDoc treba učitati futprintove komponenti iz 

Schematic editora. Izgled ekrana PCB editora nakon učitavanja futprintova komponenti prikazan 

je na Slici 94.  

Slika 94.  Futprintovi komponenti nakon učitavanja u PCB Editor 

Sledeći korak je raspoređivanje futprintova komponenti po radnoj površini. U ovom primeru treba 

voditi računa o tome da je radna frekvencija FM predajnika ~ 100MHz, odnosno kolo poseduje 

visokofrekventni oscilator (tranzistor sa pripadajućim komponentama), ovaj oscilator je potrebno 

fizički izdvojiti na jednu stranu poloče, a niskofrekventni pojačavački deo na drugi deo ploče. 

Primer mogućeg rešenja razmeštaja komponenti dat je na Slici 95, gore. Oznake komponenti su 

smanjene i premeštene u njihovu unutrašnjost iz estetskih razloga. 

 

2.3.12.1. Promena parametara koja se odnosi na više komponentata odjednom, 
korišćenjem opcije “Find Similar Objects” 

 

Postupak promene veličine tekstualnih oznaka u PCB editoru na svim komponentama odjednom 

moguće je uraditi odabirom desnog tastera miša na samoj oznaci Designator-a u ovom slučaju bilo 

koje komponente i odabirom opcije “Find Similar Objects”. Nakon ovog odabira, pojavljuje se 

prozor sa atributima prikazan na Slici 96. 
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Slika 95. Pronalaženje sličnih objekata i zajednička zamena određenih parametara 

Ovde je potrebno istaći po čemu se ove komponente klasifikuju, odnosno šta im je zajedničko, i 

to prebaciti u fokus. U našem slučaju, tip objekta je tekst, i to je već potvrđeno kao Same 

parameter, zatim, kod polja Layer treba da umesto Any postavimo Same, i isto to da se učini i za 

Text Height i Text Width, jer su po tim kriterijumima svi designatori komponenti isti. Pored toga, 
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potrebno je označiti opcije Select Matched i Run Inpector. Zatim je potrebno kliknuti na Apply, 

pa OK. 

Nakon toga se otvara prozor Run Inspector, u kome ćemo izmeniti teksutalnim unosom vrednosti 

Text Height i Text Width postavivši ih na željenu vrednost i zatim nakon toga pritisnuti ENTER i 

zatvoriti Run Inspector prozor. Izmene će odmah postati vidljive na svim označenim designatorima 

(Slika 96). 

 
Slika 96.  Run Inspector prozor u PCB Editoru 

Na ovaj način može se menjati i footprint ili bilo koji drugi parametar komponenti u PCB ili 
Shematic Editoru, upotrebom Find Similar Objects, i Run Inspector dijaloga. 
 

2.3.13.  Postavke pravila rutiranja 
 
 Nakon ovih izmena, definisaćemo pravila rutiranja: 
 

Razmak između objekata koji pripadaju različitim netovima (Clearance) postavljamo na 

vrednost 10mil  
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Širina provodnih veza se postavlja na Min = 20mil, Preferred = 30mil, Max = 50mil  
Rutiranje se vrši samo u donjem sloju (Bottom Layer) 

 
Zatim se posao rutiranja obavlja ručno, koristeći alat Interactively Route Connections koji se 

nalazi u paleti sa alatima u PCB Editoru (Slika 97 pokazuje izgled i poziciju ovog alata). 

 
Slika 97.  Interactively Route Connections alat za ručno rutiranje 

Ovim alatom je potrebno proći kroz sve veze na PCB-u, odnosno svaki Pad je potrebno spojiti sa 

odgovarajućim Pad-om druge komponente sa kojom je potrebno ostvariti električni kontakt. Sve 

veze se postavljaju u Bottom sloju. Na dnu radne površine u PCB Editoru nalazi se traka sa 

slojevima, i potrebno je da se pre uzimanja alata za ručno rutiranje odabere sloj Bottom, kao što je 

prikazano na Slici 98. 

 
Slika 98.  Odabir Bottom sloja za rutiranje 

 

 Izgled ploče nakon ručnog rutiranja prikazan je na Slici 99 u sredini. 
 
Pošto je rutiranje uspešno obavljeno, pristupa se crtanju granične linije (Keepout). Potom treba 

postaviti bakarni poligon. U ovom slučaju, bakarna površina koja štiti VF deo kola od spoljnih 

uticaja će biti postavljena u donjem sloju (Bottom Layer) i biće povezana sa zajedničkom masom: 

net GND. Konačan izgled ploče nakon postavljanja bakarnog poligona prikazan je na Slici 99 dole. 
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Slika 99.  Konačan izgled štampane ploče uređaja 
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3. Saveti prilikom dizajniranja; 3D modeli komponenti 
 

3.1.Saveti prilikom crtanja Shematskih simbola 
 

Prilikom crtanja shematskih simbola, skreće se pažnja na dodeljivanje naziva komponentama i na 

konfigurisanje pinova. 

 

Naziv 

Prilikom davanja naziva shematskom simbolu, dobro je voditi se nazivom iz datasheet-a 

proizvođača, tj. da naziv bude identičan kao “manufacturer's part name”. Izuzetci od ovog pravila 

su najčešće pasivne komponente, kaon a primer otpornici, gde se koristi generički naziv. 

 

Konfigurisanje pinova (jedan od mogućih, često primenjivanih načina): 

 Ulaze konfigurisati sa leve strane 

 Izlazne pinove konfigurisati sa desne strane 

 Vcc i ostale “Power” pinove postavljati sa gornje desne strane komponente 

 Ulazno/Izlazne pinove postavljati na sredini komponente (a takođe i na sredini komponente 

sa desne strane, ukoliko ih ima mnogo) 

 Kontrolne pinove postavljati sa gornje leve strane 

 Postavljati tipove pinova (I/O, clk, rst, negative logic) na odgovarajući način 

 

 

 

3.2.Preuzimanje gotovih Shematskih simbola i futprintova iz 
www.snapeda.com elektronskih biblioteka 

 

Shematski simboli, futprintovi, datasheet-ovi, kao i 3D modeli za većinu komponenti mogu se 

preuzeti sa internet adrese https://www.snapeda.com/home/ što znatno skraćuje i olakšava posao 

prilikom dizajniranja shematika i štampane ploče. U polje za pretragu, koje se vidi na Slici 100  
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Slika 100.  www.snapeda.com 

unosi se naziv komponente (npr. LM358) i nakon klika na taster „Search“, pojavljuju se 

informacije koje su dostupne za datu komponentu. Slika 101 prikazuje rezultat pretrage 

komponente LM358. 

 

 
Slika 101.  Rezultat pretrage za komponentu LM358 
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Nakon klika na shematic simbol jedne od pomuđenih komponenti iz liste pretrage, potrebno je 

odabrati odgovarajući format, odnosno naglasiti da se želi preuzeti komponenta koja je 

kompatibilna sa Altium bibliotekama (Slika 102). 

 
Slika 102.  Format za alstium biblioteku 

Nakon odabira formata biblioteke, biće potrebno ulogovati se pre preuzimanja fajla (Ukoliko 

proces logovanja nije ranije obavljen). Podaci za logovanje su: 

 

Username: student.ftn.e1.1@gmail.com 

Password: prakticnaelektronika 

 

ali je moguće i besplatno kreitati sopstveni nalog po želji. 
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Nakon preuzimanja fajla, može se primetiti da on dolazi u integrisanoj biblioteci sa ekstenzijom 

.IntLib, koja sadrži i simbol i futprint. Kada se ovaj fajl pokrene u Altiumu, potrebno je odabrati 

Extract Sources, (Slika 103) i tada se u Workspace panel-u otvara LibPkg biblioteka (Slika 104). 

Slika 104.  Pokretanje otpakovane integrisane biblioteke 

Odabiom iz workspace panela na SCH library, možemo kopirati shematski simbol komponente, 

kao što je prikazano na Slici 105 (desni taster miša na polje koje označava komponentu i klik na 

Copy). Zatim se ova komponenta iz clipboard-a može prelepiti u bilo  

Slika 103.  Otpakivanje integrisane biblioteke 
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Slika 105.  Kopiranje citave komponente u clipboard 

Koju drugu biblioteku. U ovom primeru napravićemo njenu kopiju u shematskoj biblioteci koja je 

kreirana u vežbi 1a. Klikom na Project, potrebno je vratiti se na biblioteku Komponente.Schlib, u 

okviru projekta PIC Programator, a zatim opet odabrati iz workspace panela SCH Library koji se 

odnosi na tu biblioteku, Slika 106. Nakon izvršenja ovih koraka, otvara se prozor u koji 

prilepljujemo kopiranu komponentu (Slika 107).  



101 
 

 
Slika 106.  Prelazak u shematsku biblioteku kreiranu u vežbi 1a. 
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Slika 107.  Ubacivanje nove komponente u biblioteku metodom kopiranja 

Desnim tsterom miša klikne se na polje u kome se nalaze sve komponente date biblioteke i 

odabirom na Paste, komponenta iz clipboard-a se klonira. Preuzeta komponenta LM358 se sada 

nalazi i u biblioteci koja je kreirana u vežbi 1a. Na ovaj način moguće je kopirati i futprinte iz 

preuzetih biblioteka u novokreirane PCB biblioteke. 

 

3.3.   3D Step modeli komponenti 
 

U okviru futprinta moguće je postaviti i 3D model komponente, čime će se upotpuniti njen fizički 

izgled. Ovo je veoma korisno kada se prilikom projektovanja uređaja određuju dimenzije kutije, 

jer će 3d model ploče definisati visinu i oblik svake komponente (pogotovo značajno kod 

konektora koji se montiraju na krajeve ploče i visokih komponenti poput elektrolitskih 

kondenzatora, transformatora itd. čija visina diktira visinu pakovanja). 

 

Altium Designer prihvata STEP modele koji se dodeljuju futprintima nacrtanih komponenti, i oni 

određuju fizički izgled i 3d atribute komponenti. 3D modeli se mogu dodati u PCB editoru, 

prilikom rutiranja ploče, ili u PCB biblioteku komponenti. Kada se step model ubaci direktno na 

štampanu ploču prilikom rutiranja, oni ne ostaju sačuvani na futprintu te komponente, već su samo 

fizički prisutni na datoj štampanoj ploči, a kada se 3d model pridruži datoj komponenti u 

odgovarajuću PCB biblioteku, on ostaje vezan za komponnenu i pojaviće se uz nju svaki naredni 

put kada se taj futprint upotrebi. 
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3.3.1. 3D i 2D pogled u PCB editoru 
 

U PCB editoru je prilikom rutiranja aktivan 2d prikaz štampane ploče, ali se prelazak na 3d pogled 

može aktivirati pritiskom na taster „3“ na tastaturi, ili alternativno, iz padajućeg menija               

View->3D Layout Mode. Takođe, vraćanje u 2d pogled može se aktivirati pritiskom na taster „2“ 

na tastaturi, ili alternativno iz padajućeg menija: View->2D Layout Mode.  

 

3.3.2. Pridruživanje 3D .STEP ili .STP modela komponenti u PCB biblioteci 
 

Odabirom iz padajućeg menija na Place->3D Body dodaje se step model koji će definisati 3d izgled 

komponente (Slika 108). Ovo je moguće uraditi i iz 2d pogleda i iz 3d pogleda u PCB editoru, ali 

je preporučljivo postavljati 3d model dok je PCB editor podešen na 3d prikaz, jer je tada lakše 

pozicionirati komponentu na odgovarajuće mesto.  

 
Slika 108.  Dodavanje 3D tela komponenti 

 

Konkretan 3D model za komponentu u većini slučajeva moguće je pronaći na www.snapeda.com 

koristeći polje za pretragu, na sličan način kao što je to učinjeno za pretragu shematskog simbola 

i futprinta komponente (Slika 109).  
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Slika 109.  Pretraga 3D STEP/STP modela 

 

 
Slika 110.  Pregled 3D modela 

 

Potrebno je kliknuti na download i sačuvati STEP model (u nekim slučajevima će biti ponuđan i 

kao STP, oba su formata prihvatljiva u Autium-u). 
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Kada je odabran Place-3D body sa Slike 108, potrebno je označiti Generic 3D model, Embedded, 

i kliknuti na opciju Load form file, kao što je pokazano na Slici 111. 

 

 

 
Nakon odabira preuzetog STEP fajla, u prozoru Embedded Model će se pokazati fizički izgled 3d 

Modela (Slika 112). Za postavljanje 3d modela potrebno je kliknuti na OK, i pozicionirati je 

kursorom miša na određenu lokaciju koju diktira futprint komponente. Ukoliko je potrebno 

zakrenuti 3d model u odnosu na X, Y ili Z osu, dok je 3d model „u vazduhu“, kliknuti na TAB, i 

u odgovarajućem polju Rotation X, Z ili Y uneti stepen rotacije. Takođe, ukoliko model treba 

izdignuti ili spustiti u odnosu na štampanu ploču, potrebno je promeniti parametar Standoff heigh. 

Slika 111.  Parametri za odabir tipa 3D modela 
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3D model se može rotirati i nakon postavljanja na komponentu, dvostrukim klikom na sam model, 

i promenom potrebnih parametara rotacije ili visine. 

 
Slika 112.  Rotiranje po X, Y I Z osi i određivanje ofseta visine komponente 
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Nakon pravilnog postavljanja na komponentu, 3d model bi trebao da stoji kao što je prikazano na 
Slici 113. 

 
Slika 113.  Pravilno postavljannje 3D modela na komponenu u PCB biblioteci 

 

3.4.Zadatak za vežbu 
 
Zadatak za Vežbu: Kreirati novu shematsku biblioteku: Komponente.SchLib, kao i PCB biblioteku 

Komponente.PcbLib, a zatim pronaći shematske simbole, kao i futprintove i 3d modele sledećih 

komponeti, a zatim ih uvrstiti u odgovarajuće kreirane biblioteke: 

 

 LM317KTTR (linearni naponski regulator, u TO-263-3 kućištu) 

 DSPIC30F4013-30I/P (mikrokontroler u DIP-40 kućištu) 

 L298N (H-most u Multiwatt-15 kućištu) 

 BC547C (NPN tranzistor u TO-92 kućištu) 

 TSHG6200 (LED IR emitter 850 nm u 5 mm kućištu) 

 FT232RL (USB to UART conv. u SSOP-28 kućištu) 

 MAX232IN (Serial Full Tranciever RS232 u PDIP-16 kućištu). 
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3.5. Smernice prilikom dizajniranja štampanih ploča 
 

1. Dužine vodova koji nose brze digitalne signale ili klok signale treba smanjiti na najmanju 

moguću meru. 

Digitalni signali i klokovi velike brzine su često veliki izvori šuma. Što su ovi tragovi duži, to 

će biti više šuma. 

2. Dužine vodova pričvršćenih direktno na konektore (I / O pinovi na konektoru) treba da budu 

svedene na minimum. 

3. Signali sa visokofrekventnim sadržajem ne bi trebalo rutirati ispod komponenata koje koriste  

I / O signale.  

Tragovi usmereni ispod komponente mogu kapacitivno ili induktivno da spregnu deo energije 

sa tom komponentom. 

4. Svi konektori (ukoliko je to moguće) treba da se nalaze na jednoj ivici ili na jednom uglu ploče. 

Konektori predstavljaju najefikasnije delove antene u većini slučajeva. 

5. Kritični signali ili vodovi klok signala treba da budu ugneždeni između Power / GND poligona 

u sendvič slojevima (ukoliko je rutiranje višeslojno). 

6. Prilikom rutiranja, izbegavati vodove koji skreću pod 90 stepeni. 

7. Mnoge komponente (posebno veliki VLSI- Very Large Scale Integration uređaji) generišu 

značajnu količinu šuma između različitih I / O pinova. Ako je jedan od ovih uređaja povezan 

sa više konektora, ovaj šum potencijalno će formirati dobru antenu. (Uređaj će takođe biti 

osetljiviji na izračeni šum koji donosi ova antena.) 

8. Brze ili osetljive vodove (koji se ne povezuju na konektore) treba rutirati dalje od ivica 

štampane ploče. 

9. Parovi signala poput Rx / Tx, i diferencijalni parovi trebaju biti rutirani neposredno jedni pored 

drugih, i da održavaju jednaku udaljenost od bilo kojih poligona. 

Diferencijalni signali su manje podložni šumovima i manje je verovatno da će proizvesti 

zračene emisije ako su uravnoteženi (tj. ako imaju istu dužinu i održavaju istu impedansu u 

odnosu na druge provodnike). 

10. Poželjno je da razdaljina između dva susedna „Power“ (energetska) poligona na datom sloju 

treba da bude najmanje 3 mm. 

Ako su dva poligona približena jedna drugom na istom sloju, može doći do značajne 

visokofrekventne sprege. 

11. Na ploči sa Power i GND poligonima ne bi trebalo koristiti vodove za povezivanje sa Power 

ili GND netom van pomenutih poligona. Povezivanje sa poligonom treba izvršiti pomoću vija 

u blizini Power ili GND  pad-a komponente. 

Vodovi povezani sa poligonom koji se nalazi na drugom sloju zauzimaju prostor i dodaju 

induktivnost. Ako se radi o signalima visoke frekvencije, ova induktivnost može značajno 

degradirati performanse. (Ipak, na niskim frekvencijama ovo neće napraviti prevelike 

probleme). 

12. U GND poligonu ne sme biti većih praznina ili proreza. 

Obično je najbolje imati poligon tipa „Solid“  i sloj posvećen ovakvom poligonu. Svaki dodatni 

Power ili drugi signal koji mora biti izolovan od GND poligona, kada je to izvodljivo, treba da 

se u što većoj meri usmeri na slojeve koji nisu sloj posvećeni ovom poligonu. 
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Takođe je važno identifikovati potencijalne izvore šuma, antene i putanje spajanja sa svakim 

pojedinačnim dizajnom koji procenite. Najbolji dizajn neće biti uvek onaj koji je u skladu sa 

većinom smernica. Najbolji dizajn je onaj koji ispunjava sve specifikacije uz najniže troškove i 

najveću pouzdanost. 

 

 

3.6.Dodavanje Logo-a na sloj TopOverlay/BottomOverlay PCB-a 
 
Klikom na ikonicu DXP koja se nalazi u padajućem meniju, i odabirom Run Script (Slika114), 

može se pristupiti skripti koja konvertuje BMP, JPG ili PNG format slike u logo koji se smešta na 

željeni sloj u PCB Editor-u. U ovom primeru biće prikazano dodavanje logo-a u TopOverlay sloju. 

 

 
Slika 114.  DXP - >Run Script 

 
Pre pokretanja skripte, uveriti se da je skripta prekopirana na hard disku (bilo koja lokacija, ali se 
mora otpakovati iz .zip arhive), - naziv foldera sa skriptom je PCB Logo Creator, i skripta se 
nalazi u prilogu na sajtu predmeta. 
 
Nakon klika na RunScript, otvara se dijalog prozor u kome je potrebno kliknuti Browse, from 
file... i navesti putanju do skripte, kao što je to učinjeno na Slikama 115 i 116. 
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Slika 115. Učitavanje skripte 

 
 

 
Slika 116.  Odabir na RunConvertScript 

Nakon ovoga pojavljuje se novi dijalog prikazan na Slici 117, u kome se odabira sloj u kome se 

želi dodati logo, kao i, skaliranje, i sama funkcija Load, nakon čijeg izvršenja sledi Convert.  
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Slika 117.  Ubacivanje Logoa i konvertvanje 

Rezultat je prikazan na Slici 118. Umetnuti logo se može pomerati po radnoj površini, ali ako se 
želi izvršiti promena veličine logo-a, mora se ponoviti proces skaliranja, i konvertovanja. 
 

 
Slika 118.  Logo konvertovan pomoću skripte PCB Logo Creator 

 
  


